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Drawing Iindicators 
There are three options you can activate in this section of the Misc tab. Click in 
the appropriate box to Show current reference point and to Show Object Snap 
point. You can also set the drawing origin indicator by checking Absolute Zero. 

Nested XREFs 
You can disable XREF nesting on a global basis. To do this, make sure there is no 
checkmark in the Allow Nesting box. 

When ‘‘Inherit current highlight setting’’ is unchecked in the Nested XREF 
section, the nested XREFs will retain their highlight settings if you insert them in 
another drawing file. If the box is checked, the drawing file’s current settings will 
be used for XREF highlighting.  

Display External 
You can display external line types and/or hatch pattern definitions that have 
not been embedded into your drawing. To do this, check the Line Definitions 
and/or Hatch Patterns boxes. The default is to display these. 

Common Menus in DataCAD 
There are several types of menus that appear frequently as submenus throughout 
DataCAD, including selection, value, and color menus. 

Selection Menus 
Selection menus appear frequently in submenus throughout DataCAD. Selection 
refers to the way you mark drawing entities for editing purposes. There are three 
primary ways to select drawing entities: by Entity (one at a time), by Group 
(when multiple entities have been associated with one another), or by Area (an 
editing box stretched around entities). 

 
Figure 2.39: From left to right, examples of Entity, Group, and Area selection 

Along with Entity, Group, and Area, selection menus include several other 
methods for selecting parts of the drawing to edit. All of the options are not 
available in every selection menu; selection menus are tailored for each editing 
option. Selection menu options can include: 

Entity Select drawing entities one at a time; this is the default selection method. 
Group Select entities that are associated as a group. 
Point Select entities by a single point; available only when using Stretch. 
Area Select geometry wholly contained within an area that you define with a rubber band 

box. 
Fence Select geometry wholly contained within a fence that you define with a temporary 

polygon boundary. 
Crossing Select any entity that crosses an area or fence boundary. 
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6. Respond to the prompt to Enter new scaling value for this scale by typing 
=(1/32)/12 and pressing (Enter) to get the result 0.002604167. 

7. Press (Enter) to accept this value as a new scale factor. 

 To calculate an angle:  

1. Respond to the prompt to enter an angle by typing =ATAN(6,12), where 6 
is the rise and 12 is the run. 

2. Press (Enter) to calculate an angle of 26.33.54, or 26° 33’ 54’’. 

Color Menus 
When an option requires you to assign a color, a list of colors appears in the 
Menu Window along with the options Custom, Match, and No Change.  

 
Figure 2.41: A sample color menu 

Custom opens the Color Palette dialog box so you can change a color by 
adjusting its red, green, and blue (RGB) and hue, saturation, and brightness 
(HSB) values. To work properly, it requires a 256-color driver. 

Warning: When you make a change to a color menu, you must save this new color 
palette or the colors will revert back to their original RGB values when you close 
DataCAD, even if you save the drawing. See “Customizing Colors” in the “Before You 
Draw” chapter for more information on how to save palettes. 

 To change the color of one or more entities in your drawing: 

1. Click on Custom in any color menu. The Color Palette dialog box 
appears. 
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Figure 2.42: The Color Palette dialog box 

2. Choose a color swatch, excluding the ones in the top row. (The top row 
contains the 15 standard colors DataCAD uses.) If you are satisfied with 
one of the colors in the dialog box, double-click on the swatch to activate 
that color and dismiss the Color Palette. If you want a color that is not 
shown on the Color Palette, continue to step 3. 

3. Click on Edit. The Color Picker dialog box appears. 
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Figure 2.43: Color Picker dialog box 

4. Adjust the RGB and HSB values for the current color (shown in the Old 
Color box) until you see the color you want in the New Color box. 
Alternatively, you can enter a new value for Red, Green, or Blue as well as 
for Hue, Saturation, or Brightness to adjust the color. You can click Cancel 
to close the Color Picker and Color Palette dialog boxes without saving 
your changes. Click OK to change the color. You return to the drawing 
where you are prompted to Select entity to <CHANGE>. 

5. Click on the entity whose color you want to change. DataCAD substitutes 
the new color for the old one. 

 To change the color of one entity to match that of another entity: 

1. Click on Match in the color menu. 

2. Select the entity whose color you would like to match. 

3. Select the entity whose color you would like to change. You can select 
multiple entities or groups without repeating steps 1 and 2. Click on No 
Change to exit the color menu without making a change. 
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Working with Dual Monitors 
Many people find it easier to work with two monitors. In effect, this just expands 
your desktop. To increase the size of your DataCAD drawing area, you could 
move many of your toolbars (such as the menu, navigation pad, projection pad, 
symbol browser, etc.) to the second monitor. You can even expand your 
DataCAD drawing area across the two monitors. DataCAD will remember your 
last setup on this expanded desktop (across the two monitors) so that you won’t 
have to make a lot of changes the next time you open the program. 

Working with dual monitors is easy once you have your hardware (the two 
monitors) and software (usually accessed through the Windows Control Panel, 
Display Properties, Settings tab) set up properly. This may require you to 
upgrade your hardware and/or software.  

For expert advice on setting up dual monitors, consult your system administrator 
or a local computer guru. Once the dual monitors are set up and working 
properly, you’ll discover all sorts of ways to change how DataCAD appears on 
your equipment and to increase your productivity. 

Planning Your Project 
Much of your work will be editing drawings under design development. 
DataCAD is a flexible program in terms of allowing you to change what you 
have drawn. Nevertheless, the more information you have when you first draw 
something, the less time you’ll spend making revisions. 

With traditional manual design development, you first do a rough sketch of the 
project and then gradually refine this idea into a drawing that is dimensionally 
and materially specific. Computer-aided design (CAD), however, produces a 
drawing with precise dimensions the first time it is drawn. 

This suggests that the ideal process of CAD development might be the opposite 
of manual design development. With CAD, it’s important to know such things as 
the exterior wall construction before you start to draw, so your drawing will be 
accurate from the beginning. If you finalize your floor plan before you decide on 
exterior wall construction materials, you’ll have to go back and change the 
thickness of all exterior walls to do automatic dimensioning or wall sections and 
details. In turn, this wall thickness change would impact the interior dimensions 
of rooms and may affect the modular grids of ceiling and floor tile, lighting, etc. 
Some well-thought out planning before you start to draw can save you valuable 
time. 

Gathering Project Information 
Practically speaking, it’s impossible to predict the exact dimensions and 
materials of everything in the building before you finalize the design. But a 
realizable goal is to gather as much information as possible about the 
construction of the building before you begin the design development or 
construction documents phases of the project. This keeps time-consuming 
changes to a minimum and allows the building to be drawn and dimensioned 
accurately. 
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Basic Drawing and Editing 
DataCAD is ready to draw lines immediately upon opening a drawing; notice 
that in the Create pull-down menu, Line is checked by default. You can even 
draw with custom line types to represent such things as insulation, telephone 
and electrical lines, and siding. Editing lines or anything else you draw is easy 
with DataCAD’s many editing features. 

Drawing Using the Mouse 

 To draw a line by selecting two points: 

1. Move the cursor anywhere in the Drawing Area and click. You’ve just 
selected the first end point of your first line. In addition to simply clicking 
to select a point and begin drawing, you can snap to a point on another 
entity and begin drawing from there. See ‘‘Object Snapping’’ in the 
‘‘Drawing Tools’’ chapter for more information. 

2. Move the cursor to the point where you want the line to end and click. 
The line is drawn. Notice, however, that if you move your cursor, it is still 
connected to the end of the line. This allows you to continue drawing 
lines, using the end of the previous line as the beginning of the next one. 

3. Repeat step 2 to continue drawing lines until your last end point meets 
the first end point you selected in step 1. 

4. Right-click to disconnect the cursor from the last line. 

Drawing Using Coordinate Entry 
Coordinate entry lets you draw lines more precisely by entering the exact 
coordinates of each end point of a line. In DataCAD, you have a choice of five 
coordinate entry methods or input modes: 

• Relative polar requires that you enter a distance and an angle relative to the 
last point entered. 

• Absolute polar requires that you enter a distance and an angle from absolute 
0. 

• Relative Cartesian requires that you enter an X and Y distance relative to the 
last point entered. 

• Absolute Cartesian requires that you enter an X and Y distance from 
absolute 0. 

• Distance-Direction requires that you indicate the direction with the mouse 
and then enter a distance relative to the last point entered. 
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You cannot redefine the four standard line types (solid, dashed, dotted, and dot-
dash) . These line types do not appear in the Line Type Manager. You can set the 
default attributes of these line types in the current drawing (or default drawing) 
only, but you cannot change the external definition.  

Creating your own line types is easy; DataCAD allows you to add up to 175 
custom line types such as special symbolic lines for site plan utilities, center lines, 
and highlighted lines for review. See ‘‘Creating Line Types’’ in the Appendix for a 
list of available custom line types and their settings. 

 To draw a line using a line type: 

1. Go to the Edit menu in the Menu Window; click on Line Type. A list of the 
four most common line types (solid, dotted, dashed, and dot-dash) 
appears in the Menu Window, along with options to modify a chosen line 
type’s weight, color, spacing, factor, or overshoot. 

Shortcut: Press (Alt) + (L) to access the Line Type menu. 

2. Look at a preview of a line type before you use it by moving the mouse 
cursor over the line type option in the Menu Window. If the line type you 
need is not included in the list at the top of the Line Type menu, use the 
Line Type Manager or create a new line. See ‘‘Using the Line Type 
Manager’’ in this chapter for details. 

3. Click on a line type in the Menu Window to use that line type. 

4. Click on the Factor, Spacing, Line Weight, Color, or Overshoot options to 
change the settings for the line type you chose. See ‘‘Line Type Settings’’ 
in this chapter for details on changing line type settings. 

5. Begin drawing lines as described in ‘‘Drawing Using the Mouse’’ or 
‘‘Drawing Using Coordinate Entry’’ earlier in this section. 

Using the Line Type Manager 
The Line Type Manager lets you load or reload external line type definitions into 
your drawing. In versions prior to DataCAD 11, all line types were listed and you 
would have to scroll through many options before finding the two or three you 
use most frequently. Using the Line Type Manager lets you embed only those line 
types you actually need in the current drawing file, streamlining the line 
selection process. If you later need additional line types, you can return to the 
Line Type Manager and add them to the Embedded Lines list. 

The upper section of the Line Type Manager displays the definitions that are 
currently (or will be) loaded into the active drawing. This section is used to 
modify parameters. Clicking OK or Apply will load newly selected definitions 
and/or apply changes you’ve made. Once your changes have been applied, you 
can use the Save or Save As options to save your internal definitions to the hard 
drive. You can use Reload to overwrite an internal definition with an external 
one. 

The lower section of the Line Type Manager displays external definitions that 
you may load into the active drawing. You cannot make changes to external 
definitions in this section. First, you must apply changes to internal definitions, 
the use the Save or Save As options to externalize your new settings. 
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You can manually convert DataCAD line types (.LIN) to the new (.DLT) format. 
To do this, use the Convert option in the Line Type Manager dialog box. 

Up to 255 line types are available in DataCAD. You can create your own custom 
line type definitions, too. When you give colleagues copies of your drawings that 
contain custom line types, you needn’t worry about supplying them with the 
new definitions because DataCAD automatically converts them from 
DCADWIN.LIN to individual .DLT files stored in \DataCAD\Support 
Files\Line Types. 

You can also use the Line Type Manager to set the End Correction and default 
Factor for embedded or external line type definitions. This means that you can 
customize the embedded lines. 

 To use the Line Type Manager: 

1. Go to the Edit menu in the Menu Window and click on Line Type. The 
Line Type menu appears. 

2. Click on Line Type Manager. The Line Type Manager dialog box appears. 
In the lower portion, the External Lines window contains a list of all the 
other line types you may want to use in this particular drawing file. Each 
portion of the Line Type Manager contains a preview window so that you 
can see what the highlighted line will look like. 

3. Add one of the external lines to your current drawing file by highlighting 
the line you want in the lower portion of the Line Type Manager and 
clicking on the Load button. This loads the line you selected from the 
External Lines list into the Embedded Lines list. 

4. Customize the lines in the Embedded Lines portion if necessary. 

• End Correction --- check (enable) or uncheck (disable) the End 
Correction box in the Embedded Lines portion of the Line Type 
Manager.  

• Line Spacing --- change the default factor by supplying a different 
value in the Factor input box in the Embedded Lines portion of the 
Line Type Manager.  
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Overshoot Displays extensions (or punch) at line intersections, giving drawings an architectural 

look. DataCAD always dimensions to the actual length of a line, ignoring any 
displayed overshoot.  

 
You must set the overshoot before you draw a line; previously drawn lines are 
not affected. 

By default, DataCAD lets you apply line overshoot selectively to individual 
entities in your drawing. However, you can change this and globally apply line 
overshoot to all lines in your drawing. Of course, you must toggle Overshoot on 
in the Display menu to view and/or plot the overshoots either globally or 
selectively. 

 To set the overshoot: 

1. Go to the Edit menu in the Menu Window and click on Line Type. The 
Line Type menu appears.  

2. Click on Overshoot in the Line Type menu. The Overshoot menu appears. 

3. Decide whether you want to apply line overshoot to entities selectively or 
to all lines throughout your drawing. These two options are mutually 
exclusive: 

• By Entity --- by default, this is toggled on so that you apply line 
overshoot selectively to particular entities in your drawing. 

• Globally --- by default, this is toggled off. If you want all lines 
throughout your drawing to overshoot, toggle this option on. This 
affects all future lines you draw in this file; it does not affect lines you 
drew prior to toggling this option on. The global line overshoot is 
scale-independent; it is defined as a real-world, plotted distance. 

4. Choose or type an overshoot length by clicking on New Distance, 
selecting a value, and pressing (Enter).  

 To display line overshoot in your current drawing on your monitor and on 
your plots:  

1. Go to the Utility menu and click on Display. The Display menu appears. 

2. Toggle Overshoot on. 

You can add line overshoot to an existing line in your drawing by using the 
Change menu. Depending on the option you choose in the selection portion of 
the menu, you can change one line at a time (Entity) or several at once (Group, 
Area, Fence, or Mask). 

 To display overshoot for existing lines in your drawing: 

1. Go to the Edit menu in the Menu Window and click on Change. The 
Change menu appears. 

2. Toggle on Overshoot, select a value for the length of the overshoot, and 
press (Enter). You are prompted to Select entity to <CHANGE>.  
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3. Click on the line you want to overshoot in your drawing. If you want to 
overshoot more lines, simply continue clicking on them. When you are 
finished using the overshoot, right-click to exit the Change menu. 

Basic Editing Tools 
DataCAD’s Edit pull-down menu provides easy access to most editing functions, 
including primary editing menus such as Move, Copy, Rotate, Mirror, Stretch, 
Enlarge, Erase, Change, Partial Erase, Line Cleanup, and Wall Cleanup. Choose 
any of these editing options to display that menu in the Menu Window. See the 
‘‘Editing Drawings’’ chapter for details on these options. 

The Edit pull-down menu also includes unlimited, global undo/redo options 
and cut, copy, and paste. The Undo option reverses the last action, including any 
drawing or editing, changes made using macros, or the deletion of layers. The 
Redo option restores the last action. To undo an action, click on Undo in the Edit 
pull-down menu or press (Ctrl) + (Z); to redo an action, click on Redo in the Edit 
pull-down menu or press (Ctrl) + (Y). You can also use the Undo/Redo icons in 
the Standard Toolbar.  

Cut, Copy, Paste, and Paste Special are four more Edit pull-down menu options 
you can use to edit drawings or share parts of drawings between documents. Cut 
removes entities from the drawing to the clipboard, Copy copies entities in the 
drawing to the clipboard, Paste adds entities previously cut or copied to the 
active drawing, and Paste Special lets you choose the format (metafile, text, etc.) 
for entities previously cut or copied and then adds them to the active drawing. 
To cut or copy DataCAD entities, you must first use the Clipboard Select option 
in the Edit pull-down menu to select the entities to be cut or copied. You can 
choose whether to copy just the entity or the entity with its current color and line 
weight. Check the Copy to Clipboard options on the Misc tab of the Configure 
DataCAD for Windows Settings dialog box as appropriate. 

 To move or copy entities from one drawing to another: 

1. Click on Clipboard Select in the Edit pull-down menu. A selection menu 
appears. See ‘‘Selection Menus’’ in this chapter for more information.  

Shortcut: Press (Ctrl) + (E) to access the Clipboard Select selection menu. 

2. Toggle Ins. Point on to enter an insertion point for the entities. This point 
can then be used to paste the entities into another drawing. Toggle Ins. 
Point off to enter entities relative to absolute zero. 

3. Choose a selection method by clicking on one of the selection menu 
options. 

4. Select the entities to be moved or copied. 

3. Click on Cut in the Edit pull-down menu to remove the entities from the 
drawing or click on Copy to simply copy them. If Ins. Point was toggled 
on in step 2, you are prompted to Enter the insertion point. If Ins. Point 
was toggled off, skip to step 7. 

Shortcut: Press (Ctrl) + (X) to cut entities or press (Ctrl) + (C) to copy entities. 
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4. Click in the Drawing Area to select a reference point. Your cursor will be 
attached to this reference point when you paste the entities into another 
drawing. 

Shortcut: Press (Ctrl) + (V) to paste entities. 

7. Paste them into another DataCAD drawing or into a document in another 
application: 

• Open the drawing you’d like to add the entities to and click on Paste 
in the Edit pull-down menu. Toggle By Center on to paste the entities 
by the center of their extents; toggle it off to paste the entities by their 
insertion point (if Ins. Point was toggled on) or at absolute zero. 

• Open the drawing you’d like to add the entities to, click on Paste 
Special in the Edit pull-down menu, and select a format for the 
entities. 

• Open the Windows application document that you’d like to add 
entities to and use that application’s paste function. 

You can preserve the exact position of an entity (as measured from absolute zero) 
when copying it from one drawing to another. For example, if a marker was 
placed at x=16’, y=16’ (as measured from absolute zero) in the original file, then 
pasting it into a new file using Abs. Zero will place the marker at x=16’, y=16’ 
from absolute zero in the new file. 

Referencing Drawings 
You can reference (or link) an unlimited number of DataCAD drawings to your 
current drawing. These referenced drawings (also called XREFs) are displayed in 
your current drawing and will even print as though they were part of your 
current drawing; however, they are not actually added to your current drawing, 
allowing you to keep file size as small as possible. Reference file geometry can be 
moved, copied, mirrored, or enlarged just as any other entities can be. In 
addition, reference files can be rotated into any plane in space. You can place an 
XREF in any orientation. 

There are basically four types of referenced drawings: 

• Single --- an XREF that has no nested XREFs, is not self-referencing, and is not 
circular. 

• Nested --- an XREF that you add to your drawing can contain XREFs of its 
own. These XREFs within an XREF are said to be ‘‘nested.’’ 

• Self - you can place an XREF for drawing A into drawing A. Self-referencing 
XREFs are automatically redefined to reflect the new drawing filename when 
you use the Save As function. 

• Circular --- when drawing A references drawing B and drawing B references 
drawing A. 

 To insert a reference file: 

1. Click on XREF in the Insert pull-down menu. A dialog box appears, 
prompting you to Enter name of reference file to insert. 
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2. Select a drawing from the list box and click on Open. The dialog box 
closes and a box representing the extents of the referenced drawing 
appears, attached to your cursor. The Insert XREF menu appears. 

3. Enlarge the referenced drawing before inserting it by clicking on Enlarge 
in the Insert XREF menu. A value menu appears and you are prompted to 
Enter XREF enlargement factor. 

4. Use the value menu to enter the enlargement factor you want to use and 
press (Enter).  

5. Decide if you’d like to dynamically rotate the reference file geometry into 
place when you insert it into your drawing. If you want to do this, toggle 
Dyn. Rotate on. The Dyn. Rotate option has no effect if you use Abs. Zero 
to place the reference file geometry. 

6. Select one or more of these ways to insert the reference file: 

• To insert the referenced drawing relative to absolute zero, click Abs. 
Zero in the Menu Window. The referenced file is inserted into your 
current drawing.  

• To place the referenced drawing by its center, toggle By Center on in 
the Menu Window. Move the cursor to position the referenced 
drawing and click to insert it. If you toggled Dyn. Rotate on in the 
previous step, you are prompted to Position XREF on drawing. Click in 
the Drawing Area where you want to place the XREF, rotate the 
geometry into place, and click to insert it. 

• If the By Center toggle is off, your cursor is attached to absolute zero 
in the referenced file. Move the cursor to position the referenced 
drawing and click to insert it. If you toggled Dyn. Rotate on in the 
previous step, you are prompted to Position XREF on drawing. Rotate 
the geometry into place and click to insert it. 

• If the By Center toggle is on, DataCAD calculates the extents in all 
three directions: X, Y, and Z.  

• To use the active clip cube(s) in the referenced file, toggle on XREF 
Clip. You are prompted to Position XREF on drawing. DataCAD inserts 
the active clip cube(s) into the current drawing. 

• If you don’t want the inserted XREF to include any of its nested 
XREFs, toggle on the Nesting option in the Insert XREF menu. This 
minimizes the amount of memory required to load an XREF that 
contains XREFs of its own. 

• If you want to use the Reference File Manager after inserting an XREF, 
toggle on Open RFM. 

You can also use coordinate entry to select the point to position the reference file 
geometry. See ‘‘Drawing Using Coordinate Entry’’ in this chapter for more 
information. 

Self-referencing XREFs are supported. You can place an XREF for drawing A into 
drawing A. ‘‘Circular’’ XREFs are no problem since endless-loop swap files are 
not created. Self-referencing XREFs are automatically redefined to reflect the new 
drawing filename when you use the Save As function.  
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 To insert a self-referencing XREF into your drawing: 

1. Click on Self-XREF in the Insert pull-down menu. The Insert XREF menu 
appears and a box representing the extents of the self-referenced drawing 
appears, attached to your cursor. You are prompted to Position XREF on 
drawing. 

2. Make decisions about the self-XREF by using the toggles in the Insert 
XREF menu. For more information about these options, see steps 3 
through 6 for inserting a reference file. 

3. Move the XREF box to the appropriate spot. Then click to position the 
self-XREF in your drawing. 

Referenced files may have unique clipping boundaries. You can have multiple 
Clip Cube definitions active simultaneously. You can also enter text and 
dimensions outside of the XREF Clip Cube. 

 To use XREFs with unique clipping boundaries: 

1. Select Reference File Management from the Insert pull-down menu. 

2. Select Clip Cubes from the extended menu. 

3. Choose the XREF for which you want to define a new Clip Cube. 

For information about using clip cubes from referenced files, see ‘‘Viewing 
Selected Entities in Your Model’’ in the ‘‘Viewing Your Model’’ chapter. 

Reference File Manager 
You can use the Reference File Manager to manage reference files in your current 
drawing. When you click on Reference File Management in the Insert pull-down 
menu, you can refresh or reload reference files, resolve orphaned reference files, 
or open the Reference File Manager.  

The Go To Views for an XREF appear in the Available Views window. When you 
select a Go To View from the Available Views window, you can indicate which 
layers should be on or off in the Layer Control list box. 
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Figure 2.47: The Reference File Manager dialog box 

You can also redefine loaded reference file names within the Reference File 
Manager by clicking on the Redefine button. This allows you to redefine XREF 
files that were renamed. The redefined XREF retains the previous XREF’s 
position, scale, and rotation. 

You can add the following entry to the DCADWIN.INI file to enable automatic 
conversion of referenced DC5 files to AEC format: 

[XREFs] 
Auto Convert=TRUE 

The default value is FALSE; changing it to TRUE automatically updates 
referenced DC5 files to AEC. 

Displaying Reference File Layers 

 To display only selected layers: 

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu appears. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box appears. All the reference files in your current drawing are listed in 
the Reference Files Loaded list box. 

Shortcut: Press (Ctrl) + (R) to access the Reference File Manager dialog box. 
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3. Click on a reference file in the list to select it. If necessary, you can use the 
horizontal scroll bar for reference file names that extend beyond the 
dialog window. All the layers in the reference file are listed in the Layer 
Control list box, with a checkmark next to the ones that are on 
(displayed). 

4. Click on the checkboxes next to the layers to turn layers in the reference 
file on or off. 

5. Click on Apply to apply the changes you’ve specified. The checked layers 
appear and the unchecked layers are not displayed. 

6. Click on OK to close the Reference File Manager dialog box when you’re 
finished. 

Refreshing and Reloading Reference Files 
You can refresh and reload reference files. Refresh will incorporate any changes 
you’ve made to the reference file, such as editing the drawing, but will not 
update any changes to layer status. Reload will update any changes you made to 
the reference file geometry as well as the reference file’s layer status, such as 
which layers are toggled on and which are off. 

 To refresh reference files: 

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu appears. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box appears. All the reference files in your current drawing are listed in 
the Reference Files Loaded list box. 

3. Click on a reference file in the list to select it. Press (Ctrl) or (Shift) and 
click to select multiple files. 

4. Click on Refresh. The reference file name is copied into the Marked for 
Refresh list box.  

5. Click on Apply to apply the changes you’ve specified. The selected 
reference files are refreshed. 

5. Click on OK to close the Reference File Manager dialog box when you’re 
finished. 

Double-clicking on a file listed in the Marked for Refresh, Marked for Reload, 
Marked for Bind, or Marked for Delete list boxes will remove the file from the list 
and return it to the Reference Files Loaded list box. 

 To reload reference files:  

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu appears. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box appears. All the reference files in your current drawing are listed in 
the Reference Files Loaded list box. 
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3. Click on a reference file in the list to select it. Press (Ctrl) or (Shift) and 
click to select multiple files. 

4. Click on Reload. The reference file name is copied into the Marked for 
Reload list box. 

5. Click on Apply to apply the changes you’ve specified. The selected 
reference files are reloaded. 

3. Click on OK to close the Reference File Manager dialog box when you’re 
finished. 

Double-clicking on a file listed in the Marked for Refresh, Marked for Reload, 
Marked for Bind, or Marked for Delete list boxes will remove the file from the list 
and return it to the Reference Files Loaded list box. 

Binding Reference Files 
XREFs and nested XREFs both bind, based on the On or All toggle in the XREF 
Manager. 

 To bind reference files: 

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu appears. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box appears. All the reference files in your current drawing are listed in 
the Reference Files Loaded list box. 

3. Click on a reference file in the list to select it. Press (Ctrl) or (Shift) and 
click to select multiple files. 

4. Look beside the Bind button where there are two small toggles: All and 
On. Click on All to bind all layers in the reference file to the current 
drawing, regardless of whether they’re on or not. Click on On to bind 
only the layers in the reference file that are on (displayed). Before you use 
the On toggle to bind layers of the reference file, use the Layer Control list 
box to check those layers you want toggled on. 

7. Click on Bind. The reference file name is copied into the Marked for Bind 
list box. 

Warning: The drawing file size may increase substantially when you bind 
referenced files. Binding too many files may cause the drawing file size to exceed 
the 1024MB limit. DataCAD cannot provide a warning when this occurs. Check 
the Directory (available from the Tools pull-down menu) to monitor the current 
drawing file size. 

6. Click on Apply to apply the changes you’ve specified. The selected 
reference files are bound, and their geometry is copied into the current 
drawing. Once a reference file is bound to the current drawing, it ceases 
to be a reference file. So, if you choose to bind only a few layers of a 
reference file, the entire reference file (even those layers you didn’t bind) 
is no longer linked to your current drawing. 

8. Click on OK to close the Reference File Manager dialog box when you’re 
finished. 
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Highlighting is lost when an XREF is bound because it is no longer an XREF. 

Deleting Reference Files 

 To delete reference files: 

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu appears. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box appears. All the reference files in your current drawing are listed in 
the Reference Files Loaded list box. 

3. Click on a reference file in the list to select it. Press (Ctrl) or (Shift) and 
click to select multiple files. 

4. Click on Delete. The reference file name is copied into the Marked for 
Delete list box. 

5. Click on Apply to apply the changes you’ve specified. The selected 
reference files are deleted. 

9. Click on OK to close the Reference File Manager dialog box when you’re 
finished. 

Double-clicking on a file listed in the Marked for Refresh, Marked for Reload, 
Marked for Bind, or Marked for Delete list boxes will remove the file from the list 
and return it to the Reference Files Loaded list box. 

Highlighting Reference File Geometry 
You can use color, line type, or a combination of the two to highlight reference 
file geometry. Highlighting is lost when an XREF is bound because it is no longer 
an XREF. 

 To highlight entities from a reference file: 

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu appears. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box appears.  

3. Click on the reference file in the Reference Files Loaded list box to select 
the reference file you want to highlight. 

4. Click on the On/Off checkbox in the Highlighting section to turn 
highlighting on. 

5. Choose a highlighting color and line type/line spacing from the drop-
down boxes. 

6. Click on Apply to apply the changes you’ve specified. The highlighting is 
applied to the geometry for that reference file. 

7. Repeat steps 3 --- 6 to highlight the geometry from other reference files. 

8. Click on OK to close the Reference File Manager dialog box. 
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11. Display bitmaps in your drawing using the Bitmaps toggle. Turn this 
toggle off if you want to suppress bitmaps to increase speed and refresh 
rates. 

12. Right-click to exit when you’ve finished changing Display menu settings. 

Display with arc factor set to a value of 0.5

Display with arc factor set to a value of 5.0  
Figure 7.28: Arc factor settings  

Customizing Colors 
You can use any customized palette by loading it in the Color Palette dialog box. 

 To use a standard palette: 

1. Click on Color Palettes in the Tools pull-down menu. The Color Palette 
dialog box appears. 
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Sometimes, you may need to fix wall intersections that didn’t clean properly 
when they were drawn. Use the Cleanup menu’s T Intersect, L Intersect, and X 
Intersect options to clean wall intersections. Use the Cleanup menu’s Weld Line 
and Weld Wall options to mend openings in walls. See ‘‘Cleaning Wall 
Intersections’’ and ‘‘Welding Lines and Walls’’ in the ‘‘Editing Drawings’’ chapter. 

More About Setting the Width of Walls 
When toggling on the Walls option in the Architect menu, you are prompted for a 
new wall width. A wall width is the distance between the inside and outside wall. 
You can also change wall width anytime while drawing 2-line or 3-line walls. 

 To change the width of walls to be drawn: 

1. Go to the Edit menu in the Menu Window and click on Architect. 

2. Click on Width in the Architect menu. You can also click on  in the 
context-sensitive Architect toolbar. A value menu appears. The Width 
option is not available when 4 Line Walls is toggled on. 

Shortcut: Press (=) to set the wall width. 

3. Use the value menu to enter a new width or type a new width and press 
(Enter). DataCAD sets the new wall thickness and subsequent walls will 
be drawn with that thickness. For more information on using value 
menus, see ‘‘Value Menus’’ in ‘‘The Drawing Board’’ chapter. 

More About Setting Wall Attributes 
You can assign different attributes to outside or inside walls, including colors, 
line types, and line weights by using the Highlight option in the Architect menu. 
Other attribute options apply only to 3-line or 4-line walls. 

 To draw walls with either the outside or inside wall in a different color, line 
type, or line weight: 

1. Go to the Edit menu in the Menu Window and click on Architect. 

2. Click on Highlight in the Architect menu. The Highlight menu appears.  

You can only set Highlight options for either the inside wall or the outside wall. 
For example, you can’t assign a color to the outside wall and a line type to the 
inside wall. If the Highlight menu does not appear, click on Highlight in the 
Architect menu twice. 

3. Click on Outside in the Highlight menu to highlight the outside of your 
walls. Click on Inside to highlight the inside of your walls. 

4. Click on Color to choose a highlight color, click on Line Weight to choose 
a line weight to highlight your walls with, or click on Line Type to choose 
a line type as a highlight. 

5. Right-click to return to the Architect menu. 

6. Begin drawing your walls. Notice that DataCAD applies the color, line 
type, or line weight attributes you set as you draw walls. 
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6. Use absolute zero again if necessary. Instead of your fixed reference point, 
click on Settings in the Utility menu, toggle Fixed Ref. off and then on 
again (click on the option twice); next, click on Abs. Zero. Right-click to 
exit the Settings menu and continue drawing. 

More About Setting Reference Points 
Reference points can give you a quick way to draw very precisely. For example, 
to insert a window in a wall 3’-0’’ from the corner of a room, you could create a 
reference point at that corner and then, using relative Cartesian for coordinate 
entry, simply enter the distance (in this case, it is 3’-0’’) from the reference point. 

 To use a reference point, using this example: 

1. Make sure the current input mode is Relative Cartesian. You can do this 
in several ways: click on Input Mode in the Tools pull-down menu and 
make sure Relative Cartesian is checked; check the input mode in the 
Status Panel toolbar; or press (Ins) until Current input mode = Relative 
Cartesian (x, y) appears in the Attention toolbar.  

2. Click on Window in the Create pull-down menu, or select Windows in the 

Edit/Architect menu, or click on the  icon in the Draw toolbar. The 
Windows menu appears. 

3. Press (`); the Ref. Point menu appears. 

Shortcut: To set a reference point using the mouse, press (Ctrl) and click. To set 
a reference point at a specific point on an entity by object snapping to it, press 
(Ctrl) and click the middle mouse button or press (Ctrl) + (Shift) and click the left 
mouse button. 

4. Toggle Draw Marks on to display the reference point. 

5. Object snap to the inside left corner of the wall to place your reference 
point exactly at the corner intersection. You are prompted to Select one 
jamb of window. For more information on object snapping, see ‘‘Object 
Snapping’’ in this chapter. 

6. Press (Spacebar) to activate coordinate entry. You are prompted to Enter 
relative X-distance. 

7. Type 3 and press (Enter). You are prompted to Enter relative Y-distance. 

8. Type 0 and press (Enter). Your cursor is connected to a point on the wall 
that is 3’-0’’ from the corner of the room. You are prompted to Select second 
jamb of window. 

9. Press (Spacebar) to activate coordinate entry and enter the X and Y 
coordinates for the other side of the window. You are prompted to Select 
any point on the outside of the wall. 

10. Click anywhere outside the wall. The window is drawn, exactly 3’-0’’ 
from the corner of the room. 
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Using reference points with direction-distance coordinate entry is even easier 
and faster. 

 To use a reference point and direction-distance mode, using the same 
example: 

1. Make sure the current input mode is Direction-Distance. You can do this 
in several ways: click on Input Mode in the Tools pull-down menu and 
make sure Direction/Distance is checked; check the input mode in the 
Status Panel toolbar; or press (Ins) until Current input mode = Direction, 
Distance appears in the Attention toolbar. 

2. Click on Window in the Create pull-down menu, or select Windows in the 

Edit/Architect menu, or click on the  icon in the Draw toolbar. The 
Windows menu appears. 

3. Press (`); the Ref. Point menu appears. 

4. Toggle Draw Marks on to display the reference point. 

5. Object snap to the inside left corner of the wall to place your reference 
point exactly at the corner intersection. You are prompted to Indicate the 
reference angle, which is the direction that will be used in the following 
steps. 

6. Make sure Ortho mode is on, then drag your cursor to the right and click. 
You are prompted to Select one jamb of window. 

Shortcut: To toggle Ortho mode on or off, press (O). 

7. Press (Spacebar), type 3, and press (Enter). You are prompted to Select 
second jamb of window.  

8. Drag your cursor to the right. Press (Spacebar), type the width of the 
window, and press (Enter). You are prompted to Select any point on the 
outside of the wall.  

9. Click anywhere on the exterior side. The window is inserted in the wall.  

Object Snapping 
Object snapping is a precise way of selecting a point on an existing entity or 
selecting a snap point that you’ve set. Depending on what drawing function is in 
progress, this point may simply be entered to complete the task or your cursor 
may be attached to that point so you can begin drawing from there. 

You can object snap to drawing entities and snap points in several ways. You can 
use one method or any combination of the object snapping methods described in 
this chapter.  

Shortcut: Press (N) or (Shift) + (N) to use object snapping. 

Object Snap Menu Options 
Most object snapping options are in the Utility/Object Snap menu; however, a 
related function called Get-Snap also uses snapping to help you draw. See ‘‘Using 
Get-Snap’’ later in this chapter for details. 
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None Toggles all object snap methods off. 
Fast Symbol Toggle on to snap only to symbol insertion points rather than end points within the 

symbol. Increases object snapping speed. See ‘‘More About Increasing Snapping 
Speed’’ in this chapter. 

Fast 3D Toggle on to snap to the center marker of circular 3D entities. Increases object 
snapping speed. See ‘‘More About Increasing Snapping Speed’’ in this chapter. 

Miss Dist. Set the distance your cursor can be from a point while still being able to snap to it. 
Layer Snap Toggle on to snap to entities on all displayed layers; toggle off to snap to entities only 

on the active layer. 
Search Hatch Toggle on to snap to hatch lines; toggle off to ignore hatching when object snapping 

and increase snapping speed. 
Quick Toggle on to snap to the first entity you drew; toggle off to snap to the nearest point 

according to the snapping methods you have toggled on. Increases object snapping 
speed. See ‘‘More About Increasing Snapping Speed’’ in this chapter. 

Sel. Set Toggle on to snap only to entities in the active selection set. Increases object snapping 
speed. See ‘‘More About Increasing Snapping Speed’’ in this chapter. 

Aperture Toggle on to display a box representing the miss distance. Toggle Aperture on to 
make sure the point you want to snap to is inside the miss distance.  

More About Snapping Points 
You can add snapping points anywhere in your drawing; these points are 
displayed as dots in the Drawing Area but can’t be plotted. 

 To add a snapping point to your drawing: 

1. Go to the Utility menu and click on Measures. 

2. Click on Snap Point in the Measures menu. 

3. Click in the Drawing Area or use coordinate entry to enter the snapping 
point. The point appears in the Drawing Area. 

More About Using Your Mouse for Snapping 
If you’re using a three-button mouse, set your middle mouse button to Middle 
Button; do not set it to Double Click, because you will not be able to use it for 
object snapping. If your middle mouse button doesn’t seem to be snapping to 
points, check your mouse settings. 

 To check your mouse settings: 

1. Close DataCAD if it is running. From the Windows Start menu, click on 
Settings and then on Control Panel.  

2. Double-click on Mouse in the Control Panel window to open the Mouse 
Properties dialog box.  

3. Click on the Devices tab and make sure you have a three-button mouse 
driver installed. 

4. Click on the Buttons tab and make sure the left button is set to Click 
Select, the middle button is set to Middle Button, and the right button is 
set to Alternate Menu/Click Select. If there is no Middle Button setting, 
set the middle mouse button to Unassigned or Default. Another option is 
to use Auto-Scroll. 

5. Click on OK to close the dialog box. 
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More About Increasing Snapping Speed 
There are several options you can use to increase object snapping speed. Use Sel. 
Set, Search Hatch, and Fast Symbol to more precisely target the geometry you 
want to snap to. 

The Fast 3D option can also increase snapping speed when your drawing has 
many circular 3D entities, such as 3D arcs, cylinders, cones, domes, tori, or 
contour curves. When you toggle on Fast 3D and then select entities using the 
area or fence selection method, only those entities whose center axis markers or 
control points are within the defined area or fence are selected. 

Snapping to the Nearest Point 
You can snap to the point nearest your cursor, regardless of what other object 
snap options are toggled on. For instance, even if you don’t have Mid Point 
toggled on, it is still possible to snap to the midpoint of a line using the Nearest 
option, as long as that midpoint is the point nearest to your cursor. 

 To snap to the nearest point: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. Press (PageDown) to zoom in 
on your drawing and place your cursor more accurately. 

Shortcut: Press (Shift) +(X) to access the Object Snap menu. 

2. Click on Nearest in the Object Snap menu. 

3. Move your cursor close to the point you’d like to snap to and press (N) or 
click the middle mouse button. The nearest point on any entity is snapped 
to. 

Snapping to Dividing Points 
You can divide an entity in a specified number of sections, with each section 
separated by a snapping point. These snapping points are only visible if Draw 
Marks is toggled on in the Settings menu and after you snap to them. 

 
Figure 11.1: Snapping to a point on a divided entity 

 To snap to a dividing point: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. 

2. Click on No. Points in the Object Snap menu. A value menu appears. 
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3. Set the number of divisions for an entity by use the value menu or typing 
a number. Then press (Enter). 

4. Move your cursor close to the point you’d like to snap to and press (N) or 
click the middle mouse button. The nearest division point is snapped to. 

Snapping to End Points 
You can snap to the end points of entities in your drawing. 

 
Figure 11.2: Snapping to an end point of a line 

 To snap to the nearest end point: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. You can also snap to end 
points of lines in unexploded symbols and nested symbols. For more 
information on symbols, see the ‘‘Symbols, Images, and Objects’’ chapter. 

2. Click on End Point in the Object Snap menu. 

3. Move your cursor close to the point you’d like to snap to and press (N) or 
click the middle mouse button. The nearest end point is snapped to. 

Snapping to the Midpoint of a Line 
You can snap to the nearest midpoint of a line. 

 
Figure 11.3: Snapping to the midpoint of a line 

 To snap to the nearest midpoint of a line: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. 

2. Click on Mid Point in the Object Snap menu. 

3. Move your cursor close to the point you’d like to snap to and press (N) or 
click the middle mouse button. The nearest midpoint is snapped to. 

Snapping to Arc and Circle Centers 
You can snap to the center point of an arc or circle. 
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Figure 11.4: Snapping to the center point of a circle 

 To snap to the nearest center point: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. 

2. Click on Center in the Object Snap menu. 

3. Move your cursor close to the point you’d like to snap to and press (N) or 
click the middle mouse button. The nearest center point of any arc or 
circle point is snapped to. 

Snapping to Quadrant Points 
You can snap to points marking the north, south, east, or west quadrants of a 
circle or arc. 

 
Figure 11.5: Snapping to a quadrant point on a circle 

 To snap to the nearest quadrant point: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. 

2. Click on Quadrant in the Object Snap menu. 

3. Move your cursor close to the point you’d like to snap to and press (N) or 
click the middle mouse button. The nearest quadrant point is snapped to. 

Snapping to Intersections 
You can snap to the intersection of lines, arcs, and circles. 

 
Figure 11.6: Snapping to an intersection of two lines 
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 To snap to the nearest intersection point: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. 

2. Click on Intersect in the Object Snap menu. 

3. Move your cursor close to the point you’d like to snap to and press (N) or 
click the middle mouse button. The nearest intersection point is snapped 
to. 

Snapping to a Perpendicular 
You can use perpendicular snapping to draw a line that is perfectly 
perpendicular to another line, arc, or circle. 

90°

 
Figure 11.7: Snapping to a point that forms a perpendicular to a line 

 To draw a line perpendicular to another entity: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. 

2. Click on Perp. in the Object Snap menu. 

Shortcut: Press (Alt) + (O) to toggle Perp. object snapping on and off. 

3. Click in the Drawing Area or use coordinate entry to enter the first end 
point of the line. 

4. Move your cursor close to the entity you’d like to draw the line 
perpendicular to and press (N) or click the middle mouse button to snap 
to it. The nearest perpendicular point on that entity is snapped to. 

Snapping to Tangents 
You can use tangent snapping to draw a line that is tangent to an arc or circle. 

 
Figure 11.8: Snapping to a point that forms a tangent with a circle 
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 To draw a line that is tangent to an arc or circle: 

1. Go to the Utility menu and click on Object Snap. You can also click on 
Settings in the Tools pull-down menu and then click on Object Snap in the 
submenu. The Object Snap menu appears. 

2. Click on Tangent in the Object Snap menu. 

3. Click in the Drawing Area or use coordinate entry to enter the first end 
point of the line. 

4. Move your cursor close to the arc or circle you’d like to draw the line 
tangent to and press (N) or click the middle mouse button to snap to it. 
The nearest tangent point on the arc or circle is snapped to. 

Using Get-Snap 
Get-Snap allows you to input distances relative to other objects in the drawing. 
Instead of inputting a distance, you can simply object snap to a point; the 
distance between your original point and the point you snapped to is 
automatically entered. So you can quickly create, move, copy, or stretch entities 
that align with other objects without having to draw guidelines or markers first.  

Hint: You can only access Get-Snap functions with the middle mouse button, not with the 
object snap keyboard shortcut (N) or (Shift) + (N). 

 To use snapping to enter a horizontal or vertical distance: 

1. Enter a point in your drawing. This may be one end point of a wall or the 
first point in the distance to move an entity. 

2. Press and hold down (Shift) while you click the middle mouse button for 
object snap. The Get-Snap pop-up menu appears. 

 
Figure 11.9: The Get-Snap pop-up menu 

3. Click on either Get X or Get Y and begin to type a number. A value menu 
appears and the number you are typing appears in the input field in the 
Message toolbar that prompts you to Enter relative X-distance.  

4. Continue typing the X distance value and press (Enter). Another value 
menu appears and you are prompted to Enter relative Y-distance. If you 
want to enter a negative value, type the ‘‘-’’ (minus) sign at the beginning 
of the input field. 
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5. Type the Y distance value and press (Enter). If you want to enter a 
negative value, type the ‘‘-’’ (minus) sign at the beginning of the input 
field. The line extends from your initial point to the one you just 
designated. Since your cursor is attached to the last point you designated, 
you can continue to input horizontal and vertical distances to extend the 
line. 

 To add to or subtract from the Get X distance: 

1. Enter a point in your drawing. This may be one end point of a wall or the 
first point in the distance to move an entity. 

2. Press and hold down (Shift) and object snap to a point in your drawing. 
The Get-Snap pop-up menu appears. 

3. Click on Get X + Distance to enter a horizontal distance; click on Get Y + 
Distance to enter a vertical distance. A value menu appears and you are 
prompted to Enter relative distance.  

4. Type a positive value to add to the distance between your original point 
and the point you snapped to; type a negative value to subtract from the 
distance between your original point and the point you snapped to.  

5. Press (Enter). The distance is entered. 

 To use snapping to define an angle: 

1. Enter a point in your drawing. This may be one end point of a wall or the 
first point in the distance to move an entity. 

2. Press and hold down (Shift) and object snap to the point that lies along 
the angle. The Get-Snap pop-up menu appears. 

3. Click on Get Angle from the pop-up menu. A value menu appears and 
you are prompted to Enter relative distance. 

4. Use the value menu or type a length for your line and press (Enter). The 
line is created at the referenced angle and length. 

 To use snapping to define an angle, and then add or subtract from it: 

1. Enter a point in your drawing. This may be one end point of a wall or the 
first point in the distance to move an entity. 

2. Press and hold down (Shift) and object snap to the point that lies along 
the angle. The Get-Snap pop-up menu appears. 

3. Click on Get Angle + Angle in the pop-up menu. A value menu appears 
and you are prompted to Enter angle from the origin. 

4. Use the value menu to enter the angle to add to the reference angle or 
type an angle and press (Enter). The default is 90°. A value menu appears 
and you are prompted to Enter relative distance. 

5. Use the value menu to enter the length of the line or type a value and 
press (Enter). The line is created at the referenced angle and length. 
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Using Virtual Snapping 
In the Object Snap menu, the Virtual option applies only to Nearest, Intersect, 
and Perp. snapping methods. When Virtual is turned off, DataCAD's object 
snapping mechanism will only return points that lie on line segments passing 
through the current Miss Dist. (the snap aperture) and will not return either 
intersections or perpendiculars that lie beyond the endpoints of these lines. 
 
By default, Virtual is toggled off. If you want Virtual to be toggled on when you 
open drawings created prior to DataCAD 10 for the first time, you can add the 
following entry to the [General] section of the DCADWin.Ini file: 
 
Virtual Snapping=TRUE 

 To use virtual snapping: 

1. Click on Object Snap in the Utility menu. The Object Snap menu appears. 

2. Make sure that one of the options Nearest, Intersect, and Perp. is active. 

3. Toggle Virtual on. 

Identifying Entities 
You can review the attributes of any entity in your drawing. 

 To identify an entity: 

1. Click on Identify in the Tools pull-down menu; or click on Identify in the 

Edit menu in the Menu Window; or click on the  icon in the Edit 
toolbar. The Identify menu appears. 

Shortcut: Press (Shift) + (I) or (Alt) + (I) to access the Identify menu. 

2. Click on the entity in your drawing that you want to identify. The selected 
entity is temporarily displayed as dashed lines and a list of its attributes 
appears in the Menu Window. It may be necessary to change the view of 
your drawing, so that you have a clear view of the entity you want to 
identify. Click on 3D Views in the Identify menu to display the 3D Views 
menu and change the view of your drawing, choose a view from the View 
pull-down menu, or simply zoom in on your drawing. 

3. Change the current settings for line type, layer, line color, line weight, 
overshoot, and line spacing to match those of the entity you identified in 

step 2 by clicking on Set All. You many also use the  icon in the Edit 
toolbar for Set All. The settings are changed; any entities you 
subsequently draw will automatically have those attributes, until you 
change them again. 

 To identify an entity with the pop-up menu: 

1. Place your cursor on the entity you want to identify. 

2. Hold down the (Ctrl) key while you right-click with the mouse. The 
entity appears as a dashed line and a pop-up menu appears. 
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5. Continue selecting segments to be trimmed or leave the Free Trim menu 
by clicking on Exit or right-clicking once. 

If you get unexpected results after using Free Trim, click on Undo Free Trim in 
the Edit pull-down menu or press (Ctrl) + (Z). 

 
Figure 12.5: Selecting the line segment you want trimmed (removed) 

Welding Lines and Walls 
You can repair lines and walls that have breaks in them, making a single, 
straight, continuous line or wall. 

 To weld lines: 

1. Click on Line Cleanup in the Edit pull-down menu and then click on 
Weld Line in the submenu. You can also select Cleanup from the Edit 
menu in the Menu Window and click on Weld Line in the Cleanup menu. 

Alternatively, you can click on  in the Draw toolbar and click on  
in the Context toolbar. The Weld Line menu appears. 

Shortcut: Press (Alt) + (W) to access the Weld Line menu.  

2. Toggle Layer Search on if the lines you want to weld together are on 
different layers. You are prompted to Select first line to weld. 

3. Click on one of the lines you want to weld. You are prompted to Select 
second line to weld. 
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Figure 12.6: Two lines welded into a single line 

 To weld walls: 

1. Click on Wall Cleanup in the Edit pull-down menu and then click on 
Weld Wall in the submenu. You can also select Cleanup from the Edit 
menu in the Menu Window and then click on Weld Wall. Or you can click 

on  in the Draw toolbar and click on  in the Context toolbar. The 
Weld Wall menu appears.  

If you have already cut the walls by inserting a window or door, you 
must first erase the window or door before you can weld the walls. 

2. Toggle Layer Search on if the walls you want to weld together are on 
different layers. You are prompted to Select first point on box around wall 
opening to weld. 

3. Select the walls to be welded by drawing a rubber band box around the 
two wall ends you want to weld. There must be only two wall ends 
within the rubber band box in order for the walls to be welded. To select 
the first corner of this box, click above and to the left of the wall ends you 
want to weld. You are prompted to Select second point on box around wall 
opening to weld. 

4. Move your mouse diagonally to stretch the rubber band box around the 
two wall ends you want to weld and click. The walls are welded. If the 
two walls are not in line with each other, an error message will be 
displayed in the Attention toolbar, saying Unable to weld these walls. 
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Figure 12.7: Welding two wall ends 

Cleaning Wall Intersections 
You can clean the wall intersections of 2-line, 3-line, or 4-line walls that meet in 
an L, T, or X shape. 

 
Figure 12.8: T-shaped intersections with different wall types 

 
Figure 12.9: L-shaped intersections with different wall types 
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The Arc Factor setting controls the smoothness of clipped arcs that use a solid 
line type. 

 To activate the clip cube: 

1. Select Clip Cube from the 3D Views menu. The Clip Cube menu appears. 

2. Toggle Clip On on. 

 To create a new clip cube: 

1. Choose New Cube from the Clip Cube menu. 

2. Set Z-Min and Z-Max so that they enclose the part of the model you want. 
First set the height of the floor of the clip cube by selecting Z-Min from 
the Clip Cube menu, choosing or typing a value, and pressing (Enter). 

3. Set the height of the ceiling of the clip cube by selecting Z-Max from the 
Clip Cube menu, and choosing or typing a value, and pressing (Enter). 

4. Select the area with a rubber band box. 

5. Right-click to exit or select two new corners to reset the rubber band box. 

6. Choose Clip On to toggle the cube on. 

Drawing the
Clip cube

Clip On
 

Figure 26.18: Clip cube 

Refresh updates the screen after you activate the clip cube. When Refresh is off, 
press (Esc) to refresh the screen yourself to see the effects of the new clip cube. 

You can insert an XREF into your drawing and define a clip cube within it. Either 
you can do this by using the Insert pull-down menu or by selecting XREF Clip 
from the 3D Views menu. 

 To define a clip cube in an XREF attached to your drawing with Reference 
File Management: 

1. Open a new drawing or select an existing file. 

2. Attach a reference file to it by selecting XREF from the Insert pull-down 
menu.  

3. Double-click on the name of the file you want to insert. Your cursor is 
now loaded with a boundary box that represents the extents of the 
reference file. Toggle on By Center in the Insert XREF menu. You are 
prompted to Position XREF on drawing. Click the left mouse button to 
place the reference file by its center. The reference file appears in your 
Drawing Window. 
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• To set a specific rotation angle, toggle Dyn. Rotate off. Use the value 
menu or type an angle and press (Enter). 

7. Convert the symbol into standard and separate lines and arcs when you 
place it in your drawing by toggling Explode on. 

8. Place the symbol by clicking in the Drawing Area, using coordinate entry, 
or object snapping to a point in your drawing. The symbol is inserted into 
your drawing. For details on coordinate entry, see ‘‘Drawing Using 
Coordinate Entry’’ in ‘‘The Drawing Board’’ chapter. For details on object 
snapping, see ‘‘Object Snapping’’ in the ‘‘Drawing Tools’’ chapter. 

9. Repeat the previous step to continue placing the symbol in your drawing 
or right-click to exit the menu. 

Finding and Using Older Template and Symbol Files 
Before using Templates, you need to configure DataCAD 11 to look into your 
previous version’s installation folder to find the template and symbol files. 

 To configure DataCAD version 11 and higher to find template and symbol 
files from older versions: 

1. Select Program Preferences from the Tools pull-down menu anc click on 
the Pathnames tab. 

2. Set the path for Templates to C:\DataCAD\TPL\, assuming that is the 
folder in which the earlier version is installed.  

3. Set the path for Symbols to C:\DataCAD\, leaving the SYM part off 
because it is already included in the symbol paths for each of the files 
associated with the template. 

 To insert a symbol into your drawing using the Templates menu: 

1. Right-click until the Utility menu appears. 

2. Click on Templates in the Utility menu. A dialog box appears. 

Shortcut: Press (T) to open the Template menu. 

3. Locate the template you’d like to use and click on it to select it. The 
templates that come with DataCAD are in your DataCAD\Templates 
folder. 

4. Click on Open or press (Enter). The template appears on the right side of 
the Drawing Area and the Templates menu appears. 

5. Rotate the symbol into position either dynamically or by setting a specific 
rotation angle. The symbol is rotated around the insertion point, the point 
where the symbol is attached to your cursor. 

• To dynamically rotate the symbol into position when you place it in 
your drawing, toggle Dyn. Rotate on.  

• To set a specific rotation angle, toggle Dyn. Rotate off. Use the value 
menu or type an angle and press (Enter). 
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6. Change the symbol size if necessary by clicking on Enlarge in the 
Templates menu. Before you place a symbol in your drawing, you can 
increase or decrease the size of an entity by entering specific enlargement 
values for the X, Y, and Z axes: 

• To enlarge entities along the X axis, click on X Enlargmnt. Use the 
value menu or type an enlargement factor and press (Enter). 

• To enlarge entities along the Y axis, click on Y Enlargmnt. Use the 
value menu or type an enlargement factor and press (Enter). 

• To enlarge entities along the Z axis, click on Z Enlargmnt. Use the 
value menu or type an enlargement factor and press (Enter). 

• To set the line spacing enlargement factor for nonsolid line types, click 
on Line Factor. Use the value menu or type a line factor and press 
(Enter). The Line Factor setting affects how line types like Dashed are 
enlarged. A setting matching those of the X, Y, and Z enlargement 
factors will maintain the line type’s spacing. 

• To set all of these options to the same setting and enlarge the entity 
equally in all directions, click on Set All. Use the value menu or type 
an enlargement factor and press (Enter). 

7. Decide if you need to place symbols above or below the current Z-base. 
For example, when placing tree symbols on a 3D site plan, you can 
change the Z Offset option to enter the trees at the proper elevation. To set 
the vertical distance above or below the correct Z-base where you’d like 
to insert your symbols, click on Z Offset. Use the value menu or type an 
offset value and press (Enter). Enter a positive value to place the symbol 
above the current Z-base; enter a negative value to place the symbol 
below the current Z-base. 

8. Decide if you want to change the symbol. Normally, symbols are placed 
in your drawing as a single entity, so DataCAD doesn’t recognize the 
individual lines and arcs that make up the symbol. To be able to edit a 
symbol in your drawing, you must explode (or convert) the symbol into 
separate lines and arcs. To convert the symbol into separate lines and arcs 
when you place it in your drawing, toggle Explode on.  

Note: This will only explode those symbols entered into your drawing after 
Explode is toggled on. Exploded symbols appear the same as standard symbols, 
but DataCAD recognizes only the individual lines and arcs that make up the 
symbol and not necessarily their relationship to each other. 

9. Select a symbol from the template by moving your cursor over the 
symbol you want to use and clicking. A box, representing the extents of 
the symbol, is attached to your cursor at the symbol’s insertion point. The 
symbol’s insertion point is marked by a small ‘‘x’’ once you place the 
symbol in your drawing. 

You can object snap to any point on a symbol to select an insertion point other 
than the one associated with the symbol definition. This is especially useful if you 
want to align a symbol with another entity in your drawing. Simply snap to the 
symbol in the template and then snap to the entity in your drawing to place the 
symbol. 
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10. Place the symbol in your drawing by clicking in the Drawing Area, using 
coordinate entry, or object snapping to a point in your drawing. The 
symbol is inserted into your drawing.  

11. Repeat the previous step to continue placing the symbol in your drawing 
or right-click to detach from the symbol. 

12. Open a different template if necessary by clicking on New File and 
selecting another template file from the dialog box. 

13. Close the template window by clicking on Template Off. 

More About Templates and Symbols 
Each template is a graphic representation of the template (.TPL) file and appears 
with a number of divisions, each containing a symbol. The template file itself is a 
simple text file containing the name of the file, the number of rows and columns 
in the template, and the paths to the symbols associated with that template. 
When you select a template, the symbols associated with that template file 
appear in the template window. 

Creating and Editing Templates 
Templates are a very effective way to organize a library of predrawn items, 
which you can use in many different projects. You can create a template with 
symbols that you use frequently or one that supports office standards. See ‘‘More 
About Creating Templates’’ for details on defining information fields. 

Each template has information fields defined specifically for that template. 
Whenever you add a symbol to that template, you can enter information 
describing that symbol in each field. There are six standard information fields 
that are defined for every template, but you can define an unlimited number of 
additional fields. 

 To create a template: 

1. Click on Templates in the Utility menu; or if you’re already in the 
Template menu, click on New File. A dialog box appears. 

Type a name for your new template and click on Open or press (Enter). 
The dialog box closes and you are prompted with Create new file?  

3. Click on Yes to create the template. The Field 7 menu appears and you are 
prompted with Field name. All templates have six standard fields 
automatically defined for them. 

4. Decide whether you want to define additional information fields or 
simply create the template with only the standard six fields. To use only 
the standard fields, right-click and skip to step 7. To enter an additional 
field, type a name for the field (up to 20 characters) and press (Enter). A 
list of field data types appears and you are prompted to Select field type. 
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5. Notice that there are three field types available: Text, Number, and Dollar. 
To create a field that you can enter letters and numbers into, click on Text. 
To create a field that you can enter an integer into, click on Number. To 
create a field that you can enter a real number with two fixed decimal 
places, click on Dollar. Numbers entered in a text field cannot be used in 
any calculations. 

6. Repeat steps 4 and 5 to continue entering information fields.  

7. Right-click when you’ve completed entering fields. The template is 
created and displayed at the right side of the DataCAD window and the 
Templates menu appears. For information on how to add symbols to your 
new template, see ‘‘Creating and Editing Symbols’’ later in this chapter. 

More About Creating Templates 
When you create a template, DataCAD automatically defines six information 
fields: 

Field Name Field Type 
Item nam Text 
Manufact Text 
Model No Text 
Remark 1 Text 
Remark 2 Text 
Cost Dollar 
 
You can create an unlimited number of additional information fields when you 
create a template. This is the only time you can define information fields; once the 
template is created, you can’t add another field or delete a field, nor can you 
change the field’s name or type.  

While you can’t change the fields themselves, you can always edit any 
information you’ve entered into a field. All fields you create can accept up to 80 
characters of information.  

Editing Templates 
Templates you create in DataCAD have a standard number of divisions: three 
columns and 12 rows. Once you’ve created a template, you can change the 
number of divisions to suit your needs.  

The number of divisions in a template doesn’t have to equal the number of 
symbols associated with that template. You can have more divisions than 
symbols, in which case some of the divisions in your template will be empty. You 
can also have fewer divisions than symbols, so that not all symbols associated 
with that template will be displayed at once. Displaying fewer symbols will also 
increase refresh times. 

 To change the number of divisions in a template: 

1. Create your template. Then click on Divisions in the Templates menu. You 
are prompted to Enter number of columns. 

2. Use the value menu or type the number of columns for your template and 
press (Enter). You are prompted to Enter number of rows. 
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3. Use the value menu or type the number of rows for your template and 
press (Enter). The template is updated with the new divisions and you are 
returned to the Templates menu. 

Creating and Editing Symbols 
Creating and editing symbols is a very effective way to build a library of 
predrawn items that you can use in many different projects. You can draw a 
lighting fixture, create a symbol from the fixture geometry and add it to a 
template, and then very quickly place several instances of that fixture in your 
drawing.  

To quickly determine the exact path and folder name of a symbol, click on 
Symbol Name in the Templates menu and then click on the symbol. 

You can also enter descriptive information about each symbol and then edit that 
information. You can even replace symbols in your drawing with others in your 
symbol library. 

 To create a symbol and add it to a template: 

1. Click on Templates in the Utility menu. The Templates menu appears. 

Shortcut: Press (T) to display the Templates menu. 

2. Click on Save Symbol. If the Attention toolbar informs you that a file 
doesn’t exist and asks if you want to Create it?, click on Yes. A dialog box 
appears, prompting you to Enter name of symbol file to be saved. Symbol 
folders are stored in your DataCAD\Symbols folder. 

3. Make sure the folder that’s open in the dialog box is the one you want to 
save the symbol in. If it’s not, change to the proper folder. 

4. Type a name for your symbol and click on Save or press (Enter). The Save 
Symbol menu appears. Use Save Symbol to select either symbols already 
in your drawing or geometry you want to make into a symbol; both types 
of selection will be added to the currently displayed template. 

5. Choose a selection method and then select the parts of your drawing you 
want to make into a symbol. When you are finished selecting the entities 
to add to the symbol, click on Continue. You are prompted to Select an 
insertion point for symbol. 

6. Select the reference or insertion. You can click in the Drawing Area, use 
coordinate entry, or object snap to a point in your drawing. The entities 
you selected are copied into the first open space in the template; if there 
are no open spaces in the currently displayed template, the symbol can’t 
be displayed in that template until you increase the number of template 
divisions. A dialog box appears. 

7. Enter a name for your symbol in the Item name field. Supply information 
for additional fields. You can use the New button to add more fields; you 
can use the Delete button to eliminate existing fields. 

8. Click on Ok when you are finished supplying information about the 
symbol. A dialog box appears and you are asked to Enter name of symbol 
file to be saved. 
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9. Supply a name in the File name field and click on Save or press (Enter). 

10. Continue with step 3 above to save additional symbols. 

Editing Symbols 
To edit symbols, you must first explode or convert them into individual lines and 
arcs. You can do this when you insert the symbol into your drawing or after the 
symbol has been inserted. Once the symbol has been edited, you can reform the 
symbol lines and arcs into a single symbol entity, copy it back into the template, 
and then update the symbols already in your drawing. 

 To explode a symbol when you place it in your drawing and edit it: 

1. Click on Templates in the Utility menu. Then click on New File in the 
Templates menu. A dialog box appears, allowing you to choose a 
template to open.  

2. Click on the template you want to use and click on Open. The template 
appears on the right side of the Drawing Area. 

3. Toggle Explode on in the Templates menu. 

4. Click on the symbol in the template that you want to insert into your 
drawing. 

5. Place the symbol in your drawing. You can click in the Drawing Area, use 
coordinate entry, or object snap to an entity in your drawing. The symbol 
is copied to your drawing and automatically exploded into separate 
entities. 

6. Edit the symbol geometry as necessary. For more information on editing 
lines and arcs, see the ‘‘Editing Drawings’’ chapter. 

7. Copy your changes back to the template. Click on Redefine in the 
Templates menu. You are prompted to Select symbol in template to redefine.  

8. Click on the symbol in the template that you just edited in the Drawing 
Area. A selection menu appears and you are prompted to select the 
geometry you want to be your new symbol. 

9. Choose a selection method and then select the geometry for the symbol. 
Your selection is highlighted with dashed lines. If necessary, continue 
selecting geometry until all entities that you want to be included in the 
new symbol are highlighted. 

10. Click on Continue to go on with the symbol definition process. You are 
prompted to Select an insertion point for symbol. 

11. Click in the Drawing Area or use coordinate entry to select the point that 
will be used to insert the symbols in drawings. The edits to the symbol 
are copied to the template. 

12. Update all instances of that symbol in your drawing. Click on Reload in 
the Templates menu. You are prompted to Select symbol in template to 
reload. 

13. Click on the symbol in the template that you want to reload or click on 
All in the Reload menu to reload all symbols in your drawing. 
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Editing Information Fields 
You can edit information associated with symbols by selecting a symbol in a 
template or one that’s already in your drawing. Use the Reports option in the 
Templates menu to extract symbol information for all symbols used in your 
drawing and create specification reports or cost estimates.  

 To edit symbol information: 

1. Open the template that the symbol (whose information you want to edit) 
is associated with.  

2. Click on Edit Fields in the Templates menu. 

3. Click on the symbol, either in the template or in your drawing, whose 
information you want to edit. The fields for that symbol appear in the 
dialog box. 

4. Click on the field you want to edit. 

5. Type the new information for that field and press (Enter). 

6. Repeat steps 4 ---5 to continue changing field information as necessary. 

7. Edit information for another symbol by right-clicking and continuing 
with step 3 above. Right-click twice to exit back to the Templates menu.  

 To edit symbol information: 

1. Click on FormAtr in the Toolbox pull-down menu. The FormAtr menu 
appears. If FormAtr is not listed in your Toolbox menu, click Configure in 
the Macros menu and add it to the Macros in Menu list. 

2. Click on Symbols in the FormAtr menu. You are prompted to Select symbol 
to edit attribute fields. 

3. Click on the symbol. The symbol’s information appears in the Drawing 
Area. 

4. Press (Tab) to move the edit box to the text you want to change.  

5. Type the new text and press (Enter). The information is changed. 

6. Repeat steps 4 --- 5 to continue editing. 

7. Press (Esc) to exit editing and return to your drawing. You are prompted 
with Do you wish to update symbol file [symbol path and filename]? 

8. Click on Yes to update the symbol information; click on No to cancel the 
changes. 

Replacing Symbols in Your Drawing 
You can replace one symbol in your drawing with another and choose whether to 
replace one instance of that symbol or all instances throughout your drawing. 
This is useful if you’ve entered one type of bathroom sink throughout your 
drawing and you need to replace it with another type. 
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 To replace one symbol with another symbol: 

1. Click on Templates in the Utility menu. The Templates menu appears. 

2. Click on Replace in the Templates menu. The Replace menu appears and 
you are prompted to Select symbol to replace. 

3. Click on the symbol in your drawing that you want to replace. You are 
prompted to Select symbol to replace with. 

4. Choose the new symbol that will replace the original by clicking on a 
symbol in a template or on one that’s already in your drawing. A selection 
menu appears. 

5. Replace only particular instances of the symbol you selected in step 3 or 
replace all instances of that symbol. To choose particular instances of the 
symbol, choose a selection method from the menu and continue with the 
next step. To replace all instances of the symbol, click on All; all instances 
of the symbol are immediately replaced and you can skip to step 7. 

6. Select each instance of the symbol that you want to replace. Each symbol 
is replaced as you select it.  

7. Finish replacing symbols. Right-click to return to the Templates menu. 

 To replace several different symbols with another symbol: 

1. Click on Templates in the Utility menu. The Templates menu appears. 

2. Click on Replace in the Templates menu. The Replace menu appears and 
you are prompted to Select symbol to replace. 

3. Click on Any Symbol in the Replace menu. You are prompted to Select 
symbol to replace with. 

4. Choose the new symbol that will replace the original by clicking on a 
symbol in a template or on one that’s already in your drawing. A selection 
menu appears. 

5. Select each symbol you want to replace or replace every symbol in your 
drawing. To choose each symbol, choose a selection method from the 
menu and continue with the next step. To replace all symbols, click on All; 
all symbols in your drawing are immediately replaced. 

6. Select the symbols to be replaced. Each symbol is replaced as you select it.  

7. Finish replacing symbols. Right-click to exit the Replace menu and return 
to the Templates menu. 

Deleting Symbols 
You can erase symbols from your drawing or delete them from a template.  

 To erase a symbol: 

1. Click on Erase in the Edit menu. The Erase menu appears. 

2. Toggle Layer Search on if the symbols you want to erase are on a layer 
other than the active layer. 
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3. Click on a selection method in the menu. You are prompted to select the 
entities you want to erase. 

4. Select the symbols; they are erased from the drawing. You can continue 
selecting symbols to erase them. Avoid selecting a symbol where it 
crosses another entity because it may be difficult for DataCAD to know 
which entity you want to select. Zoom in on your drawing or change 
your view to select symbols more precisely. 

5. Finish erasing symbols. Right-click to exit the Erase menu. 

 To delete a symbol from a template: 

1. Click on Templates in the Utility menu. A dialog box appears, allowing 
you to choose a template to open.  

2. Click on the template with the symbol you want to delete and click on 
Open. The template appears on the right side of the Drawing Area and 
the Templates menu appears. 

3. Click on Del. Symbol in the Templates menu. You are prompted to Select 
symbol to delete from this template file. 

4. Click on the symbol you want to delete from the template. You are asked 
to confirm your selection. 

5. Click on Yes to delete the symbol; click on No to cancel the function. 

6. Continue selecting symbols to delete them from the template or right-
click to exit the Del. Symbol menu.  

More About Erasing Symbols 
When you erase symbols from your drawing, it’s important to purge the symbol 
from your drawing as well. When you add a symbol to your drawing, DataCAD 
associates that symbol with your drawing. This association is not deleted when 
you erase the symbol and continues to take up drawing file space. To delete the 
association as well, you must use the Purge Symbol option in the Templates 
menu. 

 To purge symbol associations from your drawing: 

1. Click on Purge Symbol in the Templates menu. You are asked Are you sure 
you want to purge unused symbols? 

2. Click on Yes to purge the associations with symbols that have been 
deleted; click on No to cancel the function. 

 

 





Glossary 
 

 

3D face 
The surface of a solid specified with 3D points. 

3D mesh 
A polygon mesh composed of vertices connected by lines. 

3D polyline 
Polylines with segments oriented in 3D space. 

arc 
A continuous section of a curved line. 

area 
Any part of a drawing within a rectangular window that is temporarily 
drawn during the selection process. All entities and groups enclosed 
completely within this rectangular window are included in the area. All 
entities and groups partially enclosed or not enclosed within the rectangular 
window are not included in the area.  

Attention toolbar 
A toolbar that supplies helpful information and/or hints pertaining to the 
DataCAD function you are using. You can move this toolbar anywhere in the 
DataCAD screen or onto your desktop. 

attribute 
A single value or characteristic associated with an entity.  

bulge 
A curved portion of a polyline. 

center marks 
Small marks displayed to define the exact center of arcs and circles. You can 
also use center marks with object snapping. 
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click 
To position the cursor over a selection and press and release a mouse button 
(usually the left button). This command usually refers to selecting or 
deselecting an option. 

choose 
To select a command or option from the Menu Window. 

command 
An instruction from the user to the computer to perform a function. A 
command is usually selected from the Menu Window or the Menu Bar. 

Context-sensitive toolbar 
A toolbar that appears when you perform various functions. For example, it 
could provide icons for Cleanup, Arctitect, Door swing, Window, Polyline, 
and Model options. You can also create your own context-sensitive toolbar. 
You can move this toolbar anywhere in the DataCAD screen or onto your 
desktop. 

Coordinates/Hints toolbar 
A toolbar that supplies helpful information and/or hints pertaining to the 
DataCAD function you are using. The hints usually mirror the tooltips for 
DataCAD menu items. When it isn’t displaying hints, this toolbar shows the 
coordinates that describe your cursor’s current position. Additionally, this 
toolbar provides the Z-base and Z-height. You can move this toolbar 
anywhere in the DataCAD screen or onto your desktop. 

cursor 
A graphic symbol displayed on the screen to show the location of the mouse. 

default 
Any setting or value that is preset by DataCAD. 

Default toolbars 
Two default user-definable toolbars can be active simultaneously. You can 
move these toolbars anywhere in the DataCAD screen or onto your desktop. 

dimension line 
Also called the string line, the dimension line consists of a straight line 
parallel to the points to dimension. The dimension line also contains text 
showing distance information and termination marks, consisting of arrows or 
tick marks drawn at a 45° angle. 
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division 
A graphical aid used in cylindrical balusters, newel posts, or hand rails to 
help you better visualize the cylinder. 

doughnut (donut) 
A circular object with hole in the center, composed of two concentric circles 
and a filled center. 

Drawing Window  
The area of the screen that is reserved for your drawing.  

elevation 
The height of an object. It defines the object's position in the direction of the 
Z-axis. 

Also, an orthographic view that shows the front, back, right, or left sides of 
an object. 

entity 
A straight or curved geometric element defined by two endpoints. A circle, 
ellipse, or arc is an entity, as is a B-spline or Bezier curve. A line of text is also 
considered an entity in editing operations. Edit entities alone or when linked 
as a group.  

extension line 
Extension lines typically run from the object you dimension to the line where 
the dimension appears. Extension lines are used only for linear and angular 
dimensioning. You can control the length of the extension line. DataCAD 
typically draws one extension line at each end of a dimension line, but you 
can suppress the line. 

extents 
The outer-most edges of a drawing. To ‘‘display a drawing at its extents’’ 
means to adjust the view so that the drawing fills the Drawing Window as 
much as possible while still displaying it in its entirety; the outer-most edges 
of the drawing will fit just inside the frame of the Drawing Window. Clicking 
the E in the Navigation Pad does this automatically. 

fence 
Similar to an area but allowing more flexibility, a fence is any portion of a 
drawing within a closed polygon that you draw during the selection process. 
You can select using a concave or convex polygon having up to 36 sides. 
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fit 
Specified fixed height of text that expands or contracts to the character width 
between designated points only. 

function keys 
Function keys, (F1) through (F12), are located on the keyboard and are used 
to enter commands. In DataCAD, they are associated with the commands 
that appear in the Menu Window. You can select these commands by pressing 
the associated function key on the keyboard.  

(S1) through (S0) provide access to ten additional commands, selected on the 
keyboard by holding down (Shift) while pressing the appropriate function 
key. 

grids 
Use display and snap grids to make cursor movement and positioning more 
accurate. The flexibility and control of grids are critical to computer-aided 
design. 

group 
A group is a set of entities linked together logically but not necessarily 
graphically. Entities that do not touch may be part of the same group, and 
entities that are contiguous may be part of different groups. A group may 
contain any number of entities - as many as hundreds or only one.  

Entities are linked as a group in a number of ways. A group of entities drawn 
in succession without disconnecting the cursor are linked as one group. 
Similarly a series of lines of text entered at the same time are linked as one 
group. You can link any group of entities or groups using the Group 
command. Entities are also linked or associated as one group when they are 
created at the same time with the Copy command. When an existing entity is 
edited, with the Change or Move commands, for example, it retains the same 
group associations. 

The grouping together of entities in DataCAD facilitates editing many related 
items without affecting other entities in the same portion of a drawing. 
Because they are also easily redefined, groups allow the designer to organize 
a drawing as a series of elements composed of logically related pieces or 
entities. 

keyboard shortcuts 
These key combinations perform an operation or select a setting in the 
middle of another command by interrupting the original command. Once the 
interrupt function is complete, DataCAD automatically returns to the original 
function. 
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layers 
In computer-aided design layers are the electronic equivalent of overlaid 
pieces of tracing paper, each containing a small part of the drawing 
information. Each layer can also be saved and loaded for use in other 
drawing files. 

limits 
The maximum and minimum sizes indicated by a toleranced dimension. 

line 
The most fundamental drawing entity; defined by two endpoints. 

Menu Bar 
An area of the screen, located along the top of the DataCAD screen, that 
contains pull-down menus to give you quick access to many of DataCAD’s 
most used functions. 

Menu toolbar  
A toolbar that displays DataCAD’s primary menu structure. You can position 
this toolbar anywhere on your DataCAD screen or on your desktop. 

Message toolbar 
This toolbar provides prompts and messages. The Message toolbar also 
provides an input portion that supplies prompts and displays the 
information you are entering via the keyboard. 

MultiView Windows toolbar 
A toolbar that lets you display up to 10 GoTo View windows that you can 
tear off, reposition, and resize.  

Navigation toolbar 
This toolbar displays buttons to pan around (left, right, up, and down), zoom 
in or out, zoom to an area, view the drawing at its extents, and identify the 
properties of an entity. 

ortho mode 
Used to draw entities at any angle. Press (O) to toggle Ortho mode off. To 
draw entities orthogonal to one another, press (O) again to toggle ortho mode 
back on. Modify this snap angle by setting the number of divisions under the 
Snap Angle option of the Grids menu. 
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orthographic view 
A parallel view whose lines of sight are parallel to each other and 
perpendicular to the plane of projection. Orthographic views include plan 
views and elevations. 

pan 
Move observer's view of a drawing by using the arrow keys to the right of 
the keyboard. Set the pan distance by using Scroll Dist. in the Settings menu. 

point 
Use the mouse to point to objects on the screen. Move the mouse to move the 
cursor to the appropriate location on the screen. 

Also, a point in space represented on the monitor as a dot, without width or 
height.  

polyface 
3D vertices connected in a specified order. 

polyline 
A connected sequence of lines and arc segments. 

Projection toolbar 
This toolbar controls the type of view (parallel, perspective, plan, isometric, 
oblique, and elevations) that appears in your Drawing Window. You can 
place this toolbar anywhere on your DataCAD screen or on your desktop. 

prompt 
A message that appears on the screen in the Message toolbar, providing 
information or requesting a command or user action. 

radius 
The measurement used for a cylindrical baluster, newel post, or hand rail. 
The radius is the distance from the center point of the cylinder to the side of 
the cylinder. 

raster printing 
The rendering of a graphic as an image composed of dots rather that of 
vectors, or lines. 

reference point 
An arbitrary point in the Drawing Window from which the next point 
entered will be referenced. 
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right-click 
To press and release the right mouse button. 

right-hand rule 
A rule that indicates the direction of angles. Point the thumb of your right 
hand in the direction of the axis in question. Your fingers curl in the direction 
of positive rotation. The Y axis goes up, so when you point your thumb up, 
your fingers curl toward you in the left to right direction. Negative angles, 
therefore, go from right to left. 

screen refresh 
Updates or redraws the screen from the drawing file in order to display the 
current status of your drawing. This is particularly useful to monitor your 
progress during editing operations. 

scroll back 
Use Scroll Back to view a previously-displayed portion of a list. 

scroll forward 
Use Scroll Forward to view more options when the list of available choices is 
too long to fit on a menu. 

select 
To highlight or otherwise mark an entity, icon, or text. 

selection set  
A user-defined set of entities and/or groups that contains any number of 
entities or groups. Selection sets provide increased efficiency during editing 
by reducing the time required to select entities, groups, or define areas or 
fences. 

setting 
An option that is set to a particular value. You can change settings at any 
time, and they remain in that state until you change them again. 

solid 
Solid filled figures, composed of quadrilateral (four-sided) or triangular 
(three-sided) polygons. 

SPB fills 
A solid, pattern, or bitmap can be used to fill an area instead of the standard 
vector-based hatch patterns. 
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Standard toolbar 
A toolbar that provides access to common Windows-based functions (such as 
file open, save, print, copy, paste, etc.) and some frequently used DataCAD 
ones (such as select a reference file or bitmap). You can move this toolbar 
anywhere in the DataCAD screen or onto your desktop. 

Status toolbar 
This toolbar is reserved for status information such as the current layer, layer 
color, line type, scale, slection sets, go-to views, and input mode. You can 
more this toolbar anywhere in the DataCAD screen or onto your desktop. 

string 
A series of characters. 

swap file 
A temporary file created when you enter DataCAD. It is the working file that 
constrains your drawing during a work session. This working file is 
transferred to your drawing (.AEC) file when you exit DataCAD. 

SWOTHLUDFB toolbar 
The Snap, Walls, Ortho, Text, Hatch, Line weight, User-line, Dimension, Fills, 
and Bitmap toggles are located on this toolbar. You can move this toolbar 
anywhere in the DataCAD screen or onto your desktop. 

text 
The alphabet, numerals, and special characters added to a drawing. It is 
created using fonts. 

text leaders 
Short, sometimes angled lines that are automatically drawn back to a point 
on the circumference of the object when a dimension distance is too short to 
contain dimension text. 

thickness 
The projection of a surface into 3D space. 

toggle 
An option switch that you can turn on or off. When a toggle is on, the button 
label appears in green; when a toggle is off, the button label appears in red. 

tolerance 
The total amount a specific dimension is allowed to vary, the difference 
between maximum and minimum limits. 
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trace 
A solid line with a specified width.  

undo 
An option that cancels the latest operation or command performed. It 
appears on the menu only after an action has taken place. 

vector printing 
Line-based drawings produced with commands that are either native to or 
added to a laser printer. 

view center 
The point in space at which the observer is looking. DataCAD places the view 
center in the middle of the extents, halfway between Z-base and Z-height. 

Viewer toolbar 
This toolbar changes based on the type of view you select in the Projection 
toolbar. You can move this toolbar anywhere in the DataCAD screen or onto 
your desktop. 

void 
An opening or hole created in a slab. 

zoom 
Displays objects at different scales for drawing tasks. To quickly focus on a 
portion of a drawing for detailed work, press (/) to expand that section. 
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.AEC. See Files, drawing 
.DSF. See Files, symbol 
.INI settings, 88, 654 

1 
1 Line Trim. See Cleanup, 

trimming to one line 

2 
2 Line Trim. See Cleanup, 

trimming to one line 
2 Line Walls. See Walls, 2-line 
2 Pt. Arc. See Curves, drawing 
2-point arcs, tracing, 315 

3 
3 Edge Bot. See Inclined 

polygons and slabs, 3-edged 
bottom 

3 Edge Poly. See Inclined 
polygons and slabs, 3-edged 
vertical 

3 Edge Top. See Inclined 
polygons and slabs, 3-edged 
top 

3 Line Walls. See Walls, 3-line 
3 Pt. Arc. See Curves, drawing 
3 Pt. Circ. See Curves, drawing , 

See Circles, using 3 points 
3D arcs 

divisions of, 500 
dog-leg, 499 
drawing, 498 
tangent, 498 
vertical, 499 

3D copying, 557–58 
3D cursor, 528 
3D Cursor. See Cursor, world 

snapping 
3D doors 

as symbols, 626 
casings for, 626 
cutting walls for, 625 
files, 625 
flush with wall, 629 
forms, 626 
headers for, 627 
hinge placement for, 629 

jambs, 628 
knobs, 629 
sills, 628 
stops, 629 
thickness for, 629 
trim, 627 
types of, 626 

3D drawing, 477 
3D entities 

changing attributes of, 562 
copying, 557 
editing rules, 554 
enlarging, 561 
exploding, 562 
exporting, 45 
mirroring, 559 
moving, 554 
rotating, 558–59 
rules for editing, 554 
selecting curved, 475 
stretching, 560 

3D framing, 606–18 
floor, 606–7 
roof, 609–18 
saving settings, 618 
using settings, 618 
wall, 608–9 

3D Knife 
cutting boundary edge with, 

542 
cutting polygons from TIN 

model, 541 
indenting with, 542 
raising cut polygons with, 542 
removing polygons with, 542 
settings for, 541 
used with ruled surface, 547 

3D lines 
chaining, 477 
curved, as contours, 527 
drawing, 476 
from Z-base to Z-height, 477 

3D marker 
placing on polygon, 543 
using drop point with, 543 

3D menus, selection, 52 
3D models 

adding to web page. See o2c 
as e-mail attachment. See o2c 
exporting as VRML files, 98 
walking through, 593, 595 

3D moving, 335–40 
3D polygons 

adding vertices to, 492 
creating drop mesh, 520 

deleting vertices from, 493 
editing, 492 
horizontal, 482 
moving vertices in, 493 
rectangular, 482 
vertical, 484 

3D roofs 
creating with inclined 

polygons, 486 
creating with inclined slabs, 

486 
defining boundaries for, 612 
joining, 614 
modeling, 611 
polygonal, 613 
rectangular, 613 
settings for, 616 
types of, 611 

3D sectioning tool, 548 
3D settings, 476 
3D snapping 

normal, 477 
world, 478 

3D stairs, 278–80 
balusters for, 648 
base elevation of, 641 
calculator, 640 
chases of, 643 
curved, radius of, 642 
drawing, 638 
form, 652 
handrails for, 647 
landings of, 643 
newel posts for, 650 
placement of, 642 
risers of, 644 
settings, 641 
stringers of, 646 
tread length of, 642 
treads in first run of, 642 
treads in second run of, 642 
treads in third run of, 642 
treads of, 642, 645 

3D viewing (tutorial), 164 
3D views, 567–73, 577–78 

changing center of, 568 
changing center of parallel, 

568 
changing to parallel view, 473 
elevations, 567 
isometrics, 567 
oblique, 577–78 
perspective, 573–77 
pespective (tutorial), 176 
rotation angles in, 567 
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saving an image, 591 
shaded image, 584–88 
using GoTo View, 591 
using o2c player with, 100 

3D windows, 620–25 
as symbols, 620 
casings of, 621 
cutting walls for, 620 
files, 620 
forms, 620 
glass for, 625 
headers for, 622 
height of, 621 
jambs for, 623 
muntins for, 624 
sashes for, 624 
sills for, 623 
trim for, 622 
types of, 621 
wall thickness for, 621 

3D world snapping cursor, 478 
3-point arcs, tracing, 316 

4 
4 Edge Gen. See Inclined 

polygons and slabs, 4-edged 
general 

4 Edge Para. See Inclined 
polygons and slabs, 4-edged 
parallelograms 

4 Edge Vert. See Inclined 
polygons and slabs, 4-edged 
vertical 

4 Line Walls. See Walls, 4-line 
4EdgTrap. See Inclined polygons 

and slabs, 4-edged trapezoid 

A 
Abs. Zero. See Reference point, 

fixed 
Absolute Cartesian entry, 64 

drawing line with, 65 
Absolute polar entry, 64 

drawing line with, 65 
Absolute zero, moving entities 

to, 335 
Active Only. See Layers, setting 

the active 
Add Vertex. See Vertex, adding, 

See Polylines, editing vertices 
Add View. See Elevations, 

saving views 
A-frame roofs, 487 
All On. See Layers, toggling all 

on 
And Copy. See Mirror, and copy 
Angles 

calculating, 54, 55 
dimension of between two 

lines, 395 
measure excluded between 

two lines, 312 

measure included between 
two lines, 312 

of cone of vision, 575 
of door openings, 236 
of rotation, 559 
rise, 475, 508, 512 
roll, 475, 510 
setting types of, 212 
sweep, 502 
using right-hand rule, 567 

Aperture, of miss distance, 301 
Append, adding entities to active 

selection set automatically, 
353 

Application, launching external 
in DataCAD, 101 

Arc factor, 220 
Arc of curve 

measuring length of, 311 
Arc To Edge. See Polylines, 

editing 
Arch. See Scales, setting types 
Architectural scales, 215 
Arcs 

2-point, 250 
3-point. See Curves, drawing 
center angle of, 252 
changing radius of, 255 
closed, 562 
closing 2D, for hide, 583 
connecting two lines with, 

274, 322 
dividing, 317 
divisions, for hide, 583 
drawing based on chord 

length, 254 
drawing based on included 

angle, 256 
drawing based on length, 253 
drawing based on radius, 255 
drawing with tangent line, 

257 
editing in a polyline, 271 
measuring chord length of, 

311 
tracing tangent, 316 

Area 
measuring circle or polyline, 

314 
of surface of polygons, 544 
selection, 2D, 50 
selection, 3D, 52 

Area selection, 51 
matching cursor angle, 51 
matching grid angle, 51 

Arrays 
copy rectangular, 290, 291 
copying circular, 293 
copying with, 288, 557 
creating 3D rectangular, 557 
rectangular, 557 
using Z elevations in 

rectangular, 293 
Arrows 

arrowhead style, 373 
drawing as text, 373 

drawing with Arrows macro, 
431 

on dimension line, 392 
style for dimensions, 387, 388 
style options for angle and 

curve dimensions, 395, 397 
style options for linear 

dimensions, 392 
text, drawing (tutorial), 137 

AS1100. See Scales, setting 
types 

Attributes 
3D entities,changing, 562 
added with macro, displaying 

visible, 220 
changing text, 332 
editing for symbols, 380 
for cavity in 4-line wall, 229 
for center line of 3-line wall, 

229 
for exterior distance in 4-line 

wall, 229 
for interior distance in 4-line 

wall, 229 
of text added to symbols, 376, 

428 
of text defined for symbols, 

376 
of text for symbols, 376 
wall, setting, 228 
with wall styles, 230 

Automatic, style for dimensions, 
389 

Auto-recover files, 218 
Axonometrics 

isometric views, 567 
plan obliques, 577 

B 
Backface. See Hidden line 

removal, increasing speed of 
Background color, changing 

Drawing Window, 37 
Backing up files, 91–94 
Backup 

auto-recover file (.ARB), 91 
drawing files, 91 
drawing files (.DBK), 90 
drawing sessions, 94 
saving drawing sessions, 90 

Bal/Run1. See Balusters, number 
of 

Bal/Run2. See Balusters, number 
of 

Bal/Run3. See Balusters, number 
of 

Bal/Tred. See Balusters, number 
of 

Balusters, 648 
as symbols, 649 
color of, 650 
cylindrical, 648 
depth of, 649 
divisions of, 649 
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horizontal offset of, 650 
modeling, 648 
number of, 648 
placement of, 648 
radius of, 649 
rectangular, 648 
vertical offset of, 650 
width of, 649 

Base/Height. See Z-base, to Z-
height, See 3D lines, from Z-
base to Z-height 

Base+Thk. See Z-base, to 
thickness 

BaseElev. See 3D stairs, base 
elevation of 

Batch plotting, 467–70 
customized with scripting 

language, 470 
from a single drawing, 467 
from multiple drawings, 469 
to PDF format, 470 

Beams, standard, 634 
Bearing. See Angles, setting 

types of 
Bezier curves, 261 
Bi-fold doors, 234 
Big Cursor. See Cursor, large 

displaying 
Bitmap 

displaying, 221 
inserting files into drawings, 

81 
resolving orphaned, 83 
saving image as, 86 

Bitmap Fills. See SPB Fills 
Blocks 

drawing, 494 
parallelogram, 495 
rectangular, 495 

Border 
adding center snapping point, 

435 
creating (tutorial), 154 
drawing, 434, 435 
moving (tutorial), 155 
size of, 434 

Boundaries, hatch 
defining, 404 
defining rectangular, 404 
including arcs, 404 
including curves, 404 
using contour search to 

define, 404 
Box Color. See Colors, 

displaying box 
B-spline curves, 262 

C 
Cab. See Elevators:drawing 2D 

with DataCAD AEC 
Calculating 

angles, 54, 55 
distances, 54 

Calculator, online, 54 

Calibrate 
distance, 431 
enlargement of imported 

graphics, 431 
X/Y enlargement options, 431 

Camera, 575 
Cancel 

closing dialog boxes using, 57 
hidden line removal, 579 
roof framing, 610 
saved hide image, 581 

Capacity. See Elevators, drawing 
2D with DataCAD AEC 

Casings 
of 3D doors, 626 
of 3D windows, 621 

Cent. Angle. See Curves, 
drawing 

Cent. Chord. See Curves, 
drawing 

Center Cav. See Walls, defining 
by cavity center 

Center Line. See Walls, 3-line 
attributes 

Center Point 
polygons, drawing, 249 

Center points of 2D curves, 
displaying, 220 

Center Wall. See Walls, defining 
by center 

Center Z. See Center, of 3D 
rotation 

Center, of 3D rotation, 559 
CentiMtr. See Scales, setting 

types 
Chain. See 3D lines, chaining 

creating vertical polygons in 
succession, 484 

Chamfer, 274, 275, 323 
Changing, 331–34 

attributes of 3D entities, 562 
attributes to match another 

entity, 332 
entity attributes, 331 
line overshoot, 70 
text attributes, 332 
text attributes to match 

another text block, 333 
Characters, extended, 676 
Check for spelling errors, 363 
Check plot, 458 
Chord 

drawing arc based on length 
of, 254 

measuring length of arc, 311 
Circ. Array. See Copy, circular 

array 
Circles 

3-point, 498 
dividing, 317 
measuring circumference of, 

312 
using 3 points, 260 
using diameter, 259, 498 
using radius, 258, 498 

Circumference, measuring circle, 
312 

CircWndw. See Windows, 
curved bays of 

Clean, 227 
walls, 229 

Cleanup 
chamfers, 323 
connecting two lines with a 

line, 323 
fillets, 322 
trimming to nearest, 325 
trimming to one line, 324, 325 
wall intersections, 229 
wall intersections (tutorial), 

114 
Clear Layer. See Layers, erasing 

contents of 
Clip Cube 

activating, 589 
creating, 589 
defining in XREF with 

Reference File 
Management, 589 

defining in XREF with XREF 
Clip, 590 

display boundary of, 49 
rotated, adding to a multi-

scale plot, 462 
using with XREFs, 74, 589, 

590 
viewing selected entities in 

3D model with, 588 
Clockwise. See Curves, drawing, 

See Angles, setting types of 
ClosdStr. See Stringers, closed 
Close 2D Arc. See Arcs, closing 

2D for hide 
Close Ellip. See Ellipses, closing 

for hide 
Closed, 562 
Color. See Stairs, drawing 2D 

with DataCAD AEC, See 
Layers, changing color 
changing on display grids, 

184 
Color mapping 

define materials for rendering 
with, 599 

using Viewer/Shader color 
map, 599 

Color slice 
controlling color of levels in 

TIN model, 536 
cutting TIN model, 536 
for TIN model, 536 

Colors 
changing, 55 
changing background of 

Drawing Window, 37 
changing for entities, 55 
Color Palette, 37, 55 
Color Picker, 56 
copying entities to clipboard, 

48 
custom, 55, 222 
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displaying box, 220 
exporting with Translation 

toggle, 44 
HSB values, 57 
matching, 57 
menu, 55 
of 3D stairs, 644, 646, 647 
of balusters, 650 
of handrails, 648 
of hidden lines, 582 
of newel posts, 652 
RGB values, 57 
standard 15 DataCAD, 56 

Columns, drawing, 632 
Command Line Alias, 30 
Compass. See Angles, setting 

types of 
Computer crash, recovering lost 

work after, 91–94 
Concrete forms, 632–35 

drawing column, 632 
drawing double tee, 633, 634 
drawing I-beam, 635 
drawing inverted tee, 632 
drawing single tee, 633 
drawing standard beam, 634 

Cone of vision, 574, 575 
width of, 575 

Cones 
closed, 562 
drawing, 504 
radius of, 505 
truncated, 504 

Cont. Search. See Polylines, 
converting closed shape to, 
See Contours, search closed 
polyline to create outline 

Contours 
based on 3D points or 

polygons, 543 
concentric steadily rising lines 

for TIN model, 530 
control points for, 528 
creating for TIN model, 529 
creating topographical map 

with, 527 
cyclic, 527 
divisions of, 528 
drawing, 527 
elevation of, 528 
generating TIN model from, 

530 
making topological map, 543 
natural, 527 
search closed polyline to 

create outline, 267 
smoothing surface, 520 
steadily rising, 529 
stiffness of, 520, 528, 563 
tangent, 527 
tangent point, 528 

Control points 
displaying for associative 

dimensions, 220 
for contours, 527, 528 
for mesh surfaces, 514 

Convert 
lines to walls, 334 
walls to lines, 334 

Convert Void. See Voids, 
converting, See Voids, 
converting to polygon 

Coordinate entry 
absolute Cartesian, 64, 65 
absolute polar, 64, 65 
choosing a method, 65 
distance direction, 64, 66 
drawing with, 64 
placing dimensions with, 387 
relative Cartesian, 64 
relative polar, 64, 65 

Coordinates 
screen, 570 
world, 570 

Copy, 71 
3D entities, 557–58 
and rotate entities, 342 
circular array, 293 
entities, 284–94 
new distance, 285, 287 
one-dimensional array, 289 
perpendicular to original, 286 
rectangular array, 290, 291 
specified distance and angle, 

284 
to another layer, 287 
to clipboard, setting, 49 
using arrays, 288, 557 

Copy to Clipboard 
entity color, 48 
line weight, 48 

Cover 
adding to closed polyline, 273 
removing from closed 

polyline, 273 
Crossing selection, 50, 51 
Cursor 

3D, 528 
changes to New Elevation 

Indicator, 473 
changing to New Elevation 

Indicator, 572 
large displaying, 217 
setting accuracy of, 216 
text, 358 
with o2c object attached, 429 
world snapping, 478, 555, 558 

Curve Center. See Center points 
of 2D curves, displaying 

Curve Data. See Curves, 
drawing based on surveyor's 
data 

Curves 
Bezier, 261, 514 
B-spline, 262 
drawing, 250–63 
drawing based on surveyor's 

data, 262 
drawing with control points, 

260 
measuring arc length of, 311 
measuring diameter of, 311 

measuring radius of, 311 
Customizing 

colors, 221 
display settings, 219 
drawing settings, 211 
macros, 46 
miscellaneous settings, 47 
toolbars, 19 
walk-through options, 594 

Customizing DataCAD, 32 
DXF/DWG file translation, 42 
interface settings, 34, 41 
macros, 46 
menu buttons, 35 
menu labels, 35 
miscellaneous settings, 47 
pathnames, 32 
screen calibration, 35 

Cut, 71 
Cut Wall. See Walls, cutting 
Cutout. See Windows, drawing, 

See Doors, drawing 
Cyclic contours, 527 
Cylinder. See Newel posts, 

cylindrical, See Balusters, 
cylindrical, See Handrails, 
cylindrical 

Cylinders 
closed, 562 
horizontal, 501 
setting number of divisions 

for, 503 
sweep angles, 502 
vertical, 500 
vertical, divisions of, 501 
vertical, thickness of, 501 

D 
DataCAD AEC 

2D elevators, 280–82 
2D stairs, 278–80 
drawing curved bays of 

windows with, 244 
drawing linear bays of 

windows with, 241 
drawing room labels with, 

381 
Ddrawing 

windows, 238–46 
Dec. Degrees. See Angles, 

setting types of 
Decimal. See Scales, setting 

types 
place setting, 212 
place, setting, 213 
point, floating, 212, 213 

Default 
drawing, 47 
font, 47 

Definition list 
adding a value to, 213 
angle, 213 
changing a definition, 214 
deleting a value to, 214 
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distance, 213 
editing, 214 
loading a customized, 215 
scale, 213 

Del. Edge. See Polylines, 
deleting an edge 

Del. Vertex. See Vertex, 
deleting, See Polylines, 
editing vertices 

Delete 
door settings files, 625 
double lines after hide, 581 
edge from a polyline using, 

272 
framing settings files, 606, 

608, 618 
go-to-view, 592 
layer sets, 198 
layers, 192 
reference file, 78 
saved hide image, 581 
stair settings files, 652 
text styles, 372 
vertices, 493 
wall styles, 231 
window settings files, 620 

Delete Dbl. See Hidden line 
removal, deleting double lines 
with 

Delete Layer. See Layers, 
deleting 

Depth 
of balusters, 649 
of handrails, 647 
of landings, 643 
of newel posts, 651 
of treads, 645 

Desktop 
classic, 26 

Dia. Circ. See Circles, using 
diameter 

Dialog boxes, 26 
Diameter 

curve, dimension of, 395 
of circles, 259, 498 
of curve, measuring, 311 
of polygons when drawing, 

249 
Dictionary 

adding word to user, 366 
changing language of main, 

366 
checking for spelling, 363 
selecting a new user, 369 

Dim. Points. See Control points, 
displaying for associative 
dimensions  

Dimensions, 386–97 
aligned, 386 
angle between lines, 395 
angle style for angle and 

curve, 397 
angular, 386 
arrow style for, 392 
arrows, 387, 388 
associative, 387, 388 

automatic, 388 
automatic (tutorial), 142 
automatic style for, 393 
automatic, style options for, 

389 
baseline, 389, 391, 393 
center points, 393 
changing linear, 393 
curve diameter, 395 
curve radius, 396 
DIN Standard, 391 
displaying associative, 219 
dots for, 392 
drawing string of (tutorial), 

140 
editing linear, 393 
exploding linear associative, 

394 
fixed distance of, 391 
geometric tolerances for, 391 
horizontal, 386 
increment offset of, 391 
limits for, 391 
line offset, 391 
line style for, 387, 388, 391 
line style for angle and curve, 

397 
linear, 386 
minimum distance, 393 
miss distance, 393 
moving linear, 394 
object snapping and, 387 
overall, 389 
overrun of extension lines, 

391 
parallel to entity, 386 
rotated, 386 
rounding, 391 
settings (tutorial), 139 
stretching (tutorial), 143 
stringline, 388, 389, 393 
text offset for, 390 
text style for, 387, 388, 390 
text style for angle and curve, 

396 
tick marks for, 392 
vertical, 386 

DIN. See Scales, setting types 
Direction distance, using with 

reference point, 300 
Directories, changing, 33 
Disp. Grid 1. See Display, grids 
Disp. Grid 2. See Display, grids 
Display 

associative hatch origin, 220, 
409 

customizing, 219 
external hatch patterns, 50 
external line types, 50 
grid, changing color, 184 
grids, 183 
list, 48 
negative coordinates, 217 
options, setting, 216, 217 
synchronizing distances, 218 

Dist. Sync. See Distances, 
display, synchronizing 

Distance 
copy, 286 
direction entry, 64 
direction entry, drawing line 

with, 66 
new, copy, 285 

Distances 
calculating, 54 
display, synchronizing, 218 
increment, 516 
measuring between two 

points, 310 
new, 3D move, 556 
previous stretch, 560 
previous, 3D move, 556 
stretch, in Z direction, 560 

Divide entities, 316–18 
Divisions 

contour control to generate 
TIN model, 538 

of 2D arcs, 583 
of balusters, 649 
of contours, 528 
of handrails, 647 
of mesh surfaces, 516 
of newel posts, 651 
primary, 562 
secondary, 563 
setting number for cylinders, 

503 
setting primary and 

secondary, 475 
Dn Only. See Stairs:drawing 2D 

with DataCAD AEC 
Do Float. See Decimal, point, 

floating 
DoCtr. See 3D stairs, stringers of 
DoFloat. See Scales, setting 

types 
Dog-leg. See 3D arcs, dog-leg 
DoLeft. See Handrails, on left 

side of stairs, See 3D stairs, 
stringers of 

DoLndBt. See 3D stairs, landing 
of 

DoLndTp. See 3D stairs, landing 
of 

Domes 
primary divisions of, 509 
secondary divisions of, 509 

DoNlPst. See Newel posts, 
modeling 

Door Style. See Doors, drawing 
Door Swing. See Doors, drawing 
Doors 

adding 3D (tutorial), 170 
drawing, 233–38 
drawing (tutorial), 120 
labels for, 383 
match swing color to, 236 
opening angle, 236 
removing, 237 
styles of, 234 
swing color of, 236 
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swing styles of, 236 

DoRght. See Handrails, on right 
side of stairs, See 3D stairs, 
stringers of 

DoRiser. See 3D stairs, risers of 
Dormers, drawing, 488, 489 
DoTread. See 3D stairs, treads of 
Double doors, 234 
Double tee concrete forms, 

drawing, 633, 634 
Drafting symbols, creating, 677 
Drag 

copy entities using, 285 
moving polyline using, 272 
moving using, 338 
moving using (tutorial), 155 

Drag Arc. See Polylines, editing 
arcs 

Drag Edge. See Polylines, 
repositioning 

Drag Vertex. See Polylines, 
editing vertices 

Draw Hidden. See Hidden line 
removal, drawing hidden lines 
in 

Draw Jamb. See Windows, 
drawing, See Doors, drawing 

Draw Marks. See Drawing, 
marks displaying 

Drawing 
and editing basic skills, 64–72 
cabinet elevations, 446, 447 
creating a new, 12 
creating new default, 14 
curves, 250–63 
default, 14, 47 
door elevations, 441 
doors, 233–38 
doors (tutorial), 120 
elevators, 2D, 280–82 
exterior elevations with EZ 

Tools macro, 438 
line by selecting two points, 

64 
marks displaying, 217, 237, 

241, 298 
naming, 12 
opening an existing, 10 
polygons, 248–49 
polylines, 263–78 
rectangles, 249 
set origin of, 50 
sketching freehand, 296 
stairs, 2D, 278–80 
using default to create new, 

12 
using same default for each 

new, 13 
walls, 226–33 
walls (tutorial), 107 
window elevations, 443, 445 
windows, 238 
windows (tutorial), 125 
with coordinate entry, 64 
with line types, 66 
with the mouse, 64 

Drawing Area, 32 
increasing size of, 58 
using two monitors for, 58 

Drawing session 
backup procedure, 94 
saving, 48 

Drawing Window, changing 
partitions in, 581 

Drawings 
border for, 434 
border, moving (tutorial), 155 
changing entities in, 61 
copying parts of, 60 
creating PDF file of, 457 
customizing settings, 211 
laying out plot sheets for, 461 
linking, 72 
mirroring parts of, 60 
moving entities in, 61 
plotting, 452 
printing, 452 
purging unused data, 94 
referencing, 72–80 
saving, 86 
stretching entities in, 61 
unused data in, 94 
viewing, 84 

Drop mesh, 520–27 
controlling file size, 520 
created from survey data file, 

520 
creating, 520 
importing survey data for, 521 
increases file size, 520 
over selected geometry, 521 
removing unused entities 

from, 520 
Drop point, placing 3D marker 

on polygon, 543 
DWF, exporting files, 98 
DWG 

block attributes in, 380 
DataCAD symbol attributes 

in, 380 
exporting files, 98 
files, customizing translation, 

42 
importing drawing file, 14 
saving entity assignments 

when importing, 17 
DWG Translator, translation 

tables, 656 
DwgSheet. See Border, drawing 
DXF 

exporting files, 98 
files, customizing translation, 

42 
importing drawing file, 14 

DXF Translator, translation 
tables, 656 

Dynamic 
curves, drawing, 250, 251 
polygons, drawing, 249 
tangent curves, drawing, 257 

E 
Edge factor, for smoother TIN 

model, 535 
Edit Defs. See Editing, value 

definitions 
Edit Defs.. See Definition list, 

editing 
Edit menu, 61, 71 
Edit Plane 

changing zero plane 
orientation, 473 

positioning zero plane with, 
473 

Editing 
and drawing basic skills, 64–

72 
drawings, 71 
linear dimensions, 393 
symbols, 424 
value definitions, 213 

Elevations, 438–47 
cabinet settings for, 447 
cabinet styles for, 446, 447 
creating (tutorial), 179 
creating 3D views of, 571 
creating new, 571 
door, 441 
door settings for, 442 
door styles for, 441, 443 
drawing cabinets, 446, 447 
drawing doors, 441, 443 
drawing exterior, 438 
drawing windows, 443, 445 
exterior, 438 
exterior roof settings, 439 
saving views, 572 
window settings for, 444 
window styles for, 444, 445 

Elevators 
drawing 2D with DataCAD 

AEC, 280–82 
Ellipses, 260 

closing, for hide, 583 
End Point. See Object snapping, 

to nearest end point 
End Pt. Ang. See Curves, 

drawing 
End Pt. Rad. See Curves, 

drawing 
Engineering scales, 215 
Engr. See Scales, setting types 
Enlarge, 345 

3D entities, 561 
enlargement factor, 345 
imported graphics, 431 
in X direction, 561 
in Y direction, 561 
in Z direction, 561 

Identify, 308 
Entities 

adding to a selection set, 349 
attributes of, 309 
clipping with ClipIt, 354 
copying, 71, 284–94 
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copying color of, 48 
copying line weight of, 48 
copying perpendicular to 

original, 286 
cropping with ClipIt, 354 
deleting from a selection set, 

350 
dividing, 316–18 
editing attributes, 334 
enlarging, 345 
erasing, 347 
erasing partial, 347 
grouping, 51, 348 
identifying, 308 
in a selection set using Show, 

349 
linking, 51 
linking to a go-to-view, 593 
measuring, 310–16 
mirroring, 294–96 
moving, 71 
moving specified distance and 

angle, 336 
moving to absolute zero, 335 
offsetting and copying, 286 
rotating, 342 
rotating dynamically, 343 
selecting, 50, 51 
stretching, 344 
trimming, 324, 325 
ungrouping, 348 

EqBays. See Windows, curved 
bays of, See Windows, linear 
bays of 

Erase, 347 
contents of layers, 192 
partial, 347 

Erase Void. See Voids, erasing, 
See Voids, erasing from a 
polyline 

Explode 
3D entities, 562 
converting TrueType fonts to 

3D, 376 
linear associative dimensions, 

394 
polyline, 268 
symbols, 679 

Export 
3D entity, 45 
DWF files, 98 
DWG files, 98 
DXF files, 98 
files, 44, 660 
files using Color Translation 

toggle, 44 
o2c objects, 100 
RAY or DC Render files, 100 
reference files, 45 
STL files, 99 
text, 371 
using Line types toggle, 44 
VRML files, 98, 99 
XREF files, 45 

Export Layer. See Layers, saving 
Extended characters, 676 

Extension 
left, of stair treads, 645 
right, of stair treads, 645 

Extents, viewing, 191 
Eye point, changing, 568 

F 
Fast 3D. See Object snapping, to 

center of 3D circular entities 
Fast 3D snapping, 479 
Fast Symbol. See Object 

snapping, to symbol insertion 
point 

Fence selection, 50, 51 
3D, 52 

Files 
auto-recover (.ARF), 91, 218 
auto-recover backup (.ARB), 

91 
backing up work, 91–94 
backup process, 91 
compressed format of, 88 
converting to .AEC from 

.DC3 or .DC5, 10 
customizing DXF/DWG 

translation, 42 
DataCAD User (.U$R), 90 
door, 625 
drawing (.AEC), 4, 10 
Drawing Backup (.DBK), 90 
drawing recover (.DRF), 91 
drawing swap (.$WP), 90 
exporting, 44, 97, 660 
exporting XREF, 45 
icons used for DataCAD, 88 
importing, 657 
naming conventions, 87 
project set, 469 
purging, 94 
recover process, 91 
recovering lost work, 91–94 
referencing, 72–80 
size reduction of, 88 
swap, 88 
symbol (.DSF), 5 
using archive to recover, 93 

Fillets, 274, 322 
Filter. See Layers, filtering 

layers, 556 
Filter Back. See Filter 
Filter Fwd. See Filter 
FitBays. See Windows, curved 

bays of, See Windows, linear 
bays of 

Fix Text. See Mirror, text 
position 

Fixed Ref. See Reference point, 
fixed 

Flip valley, controlling TIN 
model with, 540 

Floor framing, 606–7 
joist settings for, 607 
sill plate settings for, 607 
subfloor settings for, 607 

Fonts 
changing menu button, 37 
converting TrueType fonts to 

3D, 376 
setting default, 47 
setting text parameters for 

TrueType fonts, 374 
standard, 676 
supplied by DataCAD, 358 
TrueType (TTF), 358, 374 

FormAtr. See Entities, editing 
attributes 

Fractions, 212 
stacked, 213 

Framing, 3D, 606–18 
roof, 609–18 
wall, 608–9 

Free Trim. See Cleanup, 
trimming to nearest 

Free Zooms, remembering, 48 
Freehand, using to sketch, 296 

G 
Gable roofs, 487 
Geometry, 286 

redrawing speed for, 48 
Get-Snap, 306, See Snapping 
Girders, drawing, 632 
Glass 

for 3D windows, 243, 246 
Glass Thk. See Windows, glass 

thickness 
Glass, for 3D windows, 625 
Golden Mean, 316 

dividing a line with, 318 
Go-to-views, 591 

adding current view to the list, 
592 

adding to multi-scale plot, 
464 

batch plotting of, 468 
changing an existing, 592 
deleting a view, 592 
displayed in toolbar, 25 
linking an entity to, 593 
moving a view, 592 
renaming a view, 592 
saving current plot scale with, 

48 
using hyperlinks with, 593 
using multi-scale plotting 

with, 462 
Grads. See Angles, setting types 

of 
Grid Origin. See Grids, setting 

origin of 
GridColr. See Display grid, 

changing color 
Grids 

changing size of, 184 
changing the angle in, 185 
display, changing color of, 

184 
display, using, 183 
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matching an entity’s angle, 

185 
rotating, 185 
rotating with cursor, 218 
setting origin of, 186, 568 
setting snap angle of, 185 
snap, setting angle of, 185 
snap, using, 183 

GridSize. See Grids, changing 
size of 

Group. See Entities, grouping 
Group selection, 50, 51, 348 

H 
Handrails 

color of, 648 
cylindrical, 647 
depth of, 647 
divisions of, 647 
height of, 648 
on left side of stairs, 647 
on right side of stairs, 647 
radius of, 647 
rectangular, 647 
width of, 647 

Hatch, 400–409 
angle, 401 
associative, 408 
boundaries, 402, 404 
boundaries with curves and/or 

arcs, 404 
contour search, 404 
defining a rectangular 

boundary, 404 
displaying pattern, 219 
drawing (tutorial), 145 
drawing associative, 409 
drawing standard patterns, 

400 
master polyline with voids, 

277, 405 
origin of, 401 
patterns, 400, 401 
scale, 401 
standard patterns, 667 
type of, 400 
using SPB fills instead of, 406 

Hatch Pattern Manager, 401, 
402–3 
changing embedded hatch 

patterns, 402 
converting .PAT files to .DHP 

format, 403 
embedded hatch patterns, 402 
external hatch patterns, 402 
reloading embedded hatch 

patterns, 403 
saving embedded hatch 

patterns, 403 
Head. See 3D windows, headers 

for 
Head height 

of doors, 237 
of windows, 240 

Headers, for 3D doors, 627 
Height. See Handrails, height of 
Height+Thk. See Z-height, to 

thickness 
Help, online, 2 
Hidden Color. See Hidden line 

removal, colors of hidden 
lines 

Hidden line removal 
adding retained image to 

active layer, 580 
adding retained image to layer 

file, 580 
adding retained image to new 

layer, 580 
arc divisions for, 583 
closing 2D arcs for, 583 
closing ellipses for, 583 
colors of hidden lines, 582 
deleting double lines with, 

581 
displaying outlines in, 583 
drawing hidden lines in, 582 
hidden line types for, 582 
increasing speed of, 581, 582 
joining lines during, 581 
line spacing for hidden lines, 

582 
maximizing performance of, 

579 
offsetting an image, 580 
performing, 579 
saving image of, 580 
tutorial, 177 

Hidden Space. See Line spacing, 
for hidden lines 

Hidden Style. See Line types, for 
hidden lines 

Highlight. See Walls, setting 
attributes of 

Hip roofs, 487, 488 
Hither clip, 574 
Horizontal 3D polygons, 482 
Horizontal cylinders 

bottom half of, 503 
closed, 503 
divisions of, 503 
full, 503 
radius of, 503 
sweep angle for, 502 
sweep angles to draw half of, 

503 
top half of, 503 

Horizontal slabs, 483 
HorzOfst. See Balusters, 

horizontal offset of 
Hotkeys, for walk-through, 594 
Hotspots, 23 
Hyperlinks 

with files, 593 
with GoTo Views, 593 
with internet URLs, 593 

I 
I-beams, 635 
Identify 

Set All, 309 
Images 

calibrating enlargement of, 
430 

calibrating enlargement of 
imported, 345, 431 

enlarging, 430 
importing files into drawing, 

430 
inserting into drawings, 81 
preserving original 

dimensions of imported, 
430 

printing controls for .BMP 
and .JPG files with Pen 
Table, 431 

saving in a different file 
format, 86 

Import 
and calibrate enlargement of 

imported graphics, 345, 
431 

default settings for, 43 
DWG or DXF file, 14 
entity assignments for, 15, 43 
files, 43, 657 
image, 430 
o2c object, 429 
supported file formats, 430 
text, 371 

Import Layer. See Layers, 
loading 

In Order. See Layers, refreshing 
in order of creation 

In Sill. See Windows, drawing 
In Wall. See Windows, drawing, 

See Doors, drawing 
Inch/Dec. See Scales, setting 

types 
Inch/Frc. See Scales, setting 

types 
Inclined polygons and slabs 

3-edged bottom, 488 
3-edged top, 489 
3-edged vertical, 490 
4-edged general, 488 
4-edged parallelograms, 487 
4-edged trapezoid, 487 
4-edged vertical, 489 

Ins. Point. See Insertion point 
Inscribe. See Polygons 
Inserting 

o2c objects, 429 
self-XREF, 74 
stamps, 429 
symbols, 417 

Insertion point, 71 
Installation of DataCAD, 2 
Interface 

customizing settings for, 41 
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Interface, customizing settings 

for, 34 
Intersect. See Object snapping, 

to nearest intersection point 
Intersections 

cleaning L, 330 
cleaning T, 329 
cleaning wall, 229 
cleaning X, 330 
marking, 318 

IntrLand. See 3D stairs, 
intermediate landings of 

Inverted tee concrete forms, 
drawing, 632 

Isometric views, 571 

J 
Jamb Depth. See Windows, 

drawing, See Doors, drawing 
Jamb In. See Windows, drawing, 

See Doors, drawing 
Jamb Width. See Windows, 

width of jamb, See Doors, 
drawing 

Jambs 
for 3D doors, 628 
for 3D windows, 623 

Join. See Hidden line removal, 
joining lines during 

K 
Keyboard shortcuts, 29 

creating, 670 
creating for pull-down menu 

options, 674 
defining, 671 
standard, 672 

Knobs, for 3D doors, 629 

L 
L Intersect. See Intersections, 

cleaning L 
Labels, 380–83 

customizing, 382 
door, 383 
inserting symbol into, 382 
placing in drawing, 383 
room, 381 
window, 383 

Landings 
color of, 644 
depth of, 643 
intermediate, 644 
modeling, 643 
thickness of, 644 

Layer Manager, 199–211 
adding layers with, 207 
changing a layer’s color with, 

205 
changing a layer’s name with, 

206 

changing a layer’s number 
with, 200 

changing layer settings with, 
203 

changing on/off layer settings 
with, 203 

deleting layer(s) with, 209 
designating the active layer 

with, 204 
erasing entities from a layer 

with, 208 
exiting from, 210 
locking/unlocking layers with, 

204 
moving layers with, 201 
opening, 200 
reverting to previous layer 

settings with, 210 
sorting layers with, 201 
turning all layers on with, 203 
using Cancel in, 210 
using Undo to restore old 

layer settings, 210 
Layer Ref. See Layers, 

refreshing 
Layer search, 52, 235, 239, 475 

selection, 51 
status of, 52 
status toggle, 24 

Layer Sets 
creating, 196 
deleting, 198 
loading, 197 

Layer Snap. See Snapping, on 
layers, See Obect snapping, 
on layers 

Layers 
active, 23 
adding (tutorial), 104 
assigning colors (tutorial), 

106 
changing active (tutorial), 105 
changing color, 191 
changing the active, 23, 188 
creating, 187 
creating layer sets, 196 
customizing settings for 

symbols, 428 
defining materials for each, 

198 
deleting, 192 
deleting with Layer Sets, 198 
displaying, 189 
erasing contents of, 192 
filtering, 194, 556 
including in PDF of drawing, 

457 
loading, 195 
loading with Layer Sets, 197 
locking, 190 
moving 3D entity to, 556 
moving entities to another, 

193, 339 
moving SPB-filled entities on 

same layer, 340 
naming convention for, 196 

order of, 220 
planning, 59 
refreshing, 189 
refreshing in order of 

creation, 220 
renaming, 191 
renaming (tutorial), 104 
saving, 195 
searching for, 193, 194 
seed, 188 
setting the active, 188, 193 
setting Z base and height for, 

199 
setting Z base for current 

layer only, 472 
setting Z height for current 

layer only, 472 
swapping SPB-filled entities 

on same layer, 341 
toggling all on, 189 
toggling on and off, 189 
unlocking, 190 
using Z By Layer, 472 
viewing, 191 
Z By Layer, 199 

Layout, 461–67 
multi-scale, 462–67 
multi-scale plot, 462 
plots, 461–67 
single-scale, 462 
using Quick Layout, 462 

LeftExtn. See 3D stairs, treads of 
Line spacing, for hidden lines, 

582 
Line Type Manager, 66–69 

adding embedded line types, 
68 

changing line spacing with, 
68 

customizing embedded line 
types, 68 

enabling end correction with, 
68 

selecting external line types, 
68 

standard line types, 67 
using, 66 

Line types, 66 
creating, 67, 664 
displaying, 220 
exporting, 44 
for hidden lines, 582 
menu, 67 
settings, 69 
standard, 666 
using, 61 

Line weight, 69 
copying, 48 
displaying, 220 

Lines 
connecting two lines with, 

275, 323 
dividing, 316 
dividing with Golden Mean, 

318 
height of 2D, 309 
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marking intersection of, 318 
maximum, 338 
measure angle excluded 

between two, 312 
measure angle included 

between two, 312 
measuring angle of, 310 
measuring length of, 310 
measuring total length of, 313 
style for dimensions, 387, 388 
style options for angle and 

curve dimensions, 395, 397 
style options for linear 

dimensions, 391 
welding, 326 

LineWgt. See Line weight 
Link. See Hyperlinks 

entity to go-to-view, 593 
LinrWndw. See Windows, linear 

bays of 
Load 

layer sets, 197 
text styles, 372 
wall styles, 231 

Lock. See Layers, locking 

M 
Macros 

2D DataCAD AEC, 2D 
elevators, 280–82 

Arrows, 431 
ClipIt, 353 
customizing menu in Program 

Preferences, 46 
DataCAD AEC, 434 
DataCAD AEC, 2D stairs, 

278–80 
EZ Tools, 438, 441, 443, 446, 

448 
FormAtr, 334, 685 
FrameIt, 606, 609 
Lin2Wall, 334 
RoofIt, 611 

Mansard roofs, 487 
Marker, 480 

generating points for TIN 
model, 531 

Marking, intersection of two 
lines, 318 

Mask, 52 
adding entity attributes with, 

350 
deleting entity attributes with, 

351 
Match 

changing entities using, 332 
changing text attributes using, 

333 
colors, 57 
moving 3D entities to another 

layer, 556 
moving entities to another 

layer with, 193 
setting active layer using, 193 

snap grid to an entity, 319 
Match Door. See Doors, match 

swing color to 
Match Wall. See Windows, 

drawing, See Doors, drawing 
Materials 

defining for each layer, 198 
Max Acceleration 

increasing display speeds 
with, 49 

Max. Lines. See Lines, 
maximum, See Drag:copy 
entities using 

Measure, 310–16 
Menu Bar, 17 
Menu buttons 

changing fonts of, 37 
customizing, 35 

Menu labels 
customizing, 35 

Menu Window, 27 
classic, 28 
Edit and Utility, 28 
label options, 28 
locking, 18 
moving, 18 
tool tips, 28 
unlocking, 18 

Menus 
3D Menus, 474 
3D Views, 473, 474, 567 
Angle Type, 213 
Architect, 226 
Change, 331, 332, 333 
Cleanup, 274, 323 
Color, 55 
Copy, 284 
Curves, 250–63 
Drag, 285 
Edit, 71 
Enlarge, 345 
Erase, 347 
Freehand, 296 
GoTo View, 591 
Grids, 183 
Group, 51, 348 
Hatching, 400, 404, 406, 409 
Identify, 308 
Insert, 678 
Insert XREF, 73 
Layers, 187, 188 
Line type, 67 
Measures, 301 
Object Snap, 300, 302, 304, 

305 
Plotter, 161 
Print/Plot, 452 
Ref. Point, 298 
Rotate, 342 
Sel. Sets, 349, 350, 352, 353 
selection (entity, group, area), 

50 
Settings, 211 
Stretch, 344 
Takeoffs, 313 
Templates, 679, 681, 683, 686 

Text, 358 
Text Style, 372 
Toolbox, 611, 632 
value, 53 
Walk Through, 595 
Zoom, 84 

Mesh surfaces, 514 
control points, 517 
creating with varying Z 

elevations, 517 
divisions of, 516 
drawing manually, 515 
rectangular, 515 
setting values for Z-User 1 

and Z-User 2, 517 
vertical, 516 

Mesh, drop, 520–27 
Meters. See Scales, setting types 
Metric. See Scales, setting types 
Metric scales, 216 
Mid Point. See Object snapping, 

to nearest midpoint of line 
MilliMtr. See Scales, setting 

types 
Mirror 

3D entities, 559 
and copy, 295 
defining reflection line, 295 
entities, 294–96 
text position, 295 

Miss Dist. See Cursor, setting 
accuracy of 

Miss Dist.. See Object snapping, 
defining miss distance for 

MltLyout. See Printing, multiple 
views 

Monitor, working with two, 58 
Mouse, snapping with middle 

button, 301 
MouseWheel, using for walk-

through, 594 
Move Vertex. See Vertex, 

moving, See Polylines, 
editing vertices 

MoveZ. See Moving, in Z 
direction 

Moving 
3D entities, 555, 335–40 
3D entities to another layer, 

556 
dragging to, 338 
dragging to (tutorial), 155 
entities to absolute zero, 335 
in Z direction, 337 
linear dimensions, 394 
new angle, 339 
new distance, 337, 339 
previous distance, 337 
SPB-filled entities on same 

layer, 340 
specified distance and angle, 

336 
to another layer, 339 
using Match on 3D entities, 

556 
view sphere, 569 
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Mullions 

for windows, 245 
Mullions, for windows, 243 
Multi-scale plotting, 462–67 

adding go-to-views, 464 
renaming sheets for, 463 
rotated clip cube and, 462 
used with go-to-views, 462 

MultiView windows, displayed 
in toolbar, 25 

Muntins, for 3D windows, 624 

N 
Natural contours, 527 
Navigation pad, toolbar, 20 
Navigation toolbar, viewing 

with, 85 
Nearest. See Obejct snapping, to 

nearest point 
Neg. Dist. See Negative 

coordinates, displaying 
Negative coordinates, 

displaying, 217 
Nested XREF, 79 

globally controlling display 
of, 79 

using pop-up menu to control, 
79 

New Distance. See Copy, new 
distance 

New Elevation Indicator, 572 
and Z-base and Z-height 

settings, 572 
and zero plane, 572 
cursor changes to, 473 

NewDist. See Copy, new 
distance 

Newel posts 
as symbols, 651 
color of, 652 
cylindrical, 651 
depth of, 651 
divisions of, 651 
modeling, 650 
radius of, 651 
rectangular, 651 
width of, 651 

NewelPst. See 3D stairs, newel 
posts for 

NewLayer. See Layers, creating 
NewLine. See Tangents, 

drawing curves as 
No Change. See Color, menus 
No Prim Edge. See Hidden line 

removal, displaying outlines 
in 

No. of Sides. See Polygons 
No. Points. See Object snapping, 

to dividing point 
Normal. See Angles, setting 

types of 
Nosing. See Stairs, drawing 2D 

with DataCAD AEC 
for stair treads, 645 

round, 645 
square, 645 

NumCab. See Elevators, 
drawing 2D with DataCAD 
AEC 

NumRiser. See Stairs:drawing 
2D with DataCAD AEC 

O 
o2c 

adding 3D models as e-mail 
attachment, 100 

adding 3D models to web 
page, 100 

exporting objects, 100 
inserting object into drawing, 

82 
inserting objects, 429 
Objects to See, 100 

Object snapping, 300 
defining miss distance for, 

301 
drawing line perpendicular to 

entity, 305 
increasing speed of, 301, 302 
on layers, 301 
placing dimensions with, 387 
show point, 50 
tangent to arc, 306 
to center of 3D circular 

entities, 301 
to dividing point, 302 
to entities in active selection 

set, 301 
to hatch lines, 301 
to nearest center point, 304 
to nearest end point, 303 
to nearest intersection point, 

305 
to nearest midpoint of line, 

303 
to nearest point, 302 
to nearest quadrant point, 304 
to symbol insertion point, 301 

Object Viewer 
checking Z offset of symbols 

with, 421 
raytracing with, 598 
selecting from View menu, 

596 
using toolbar icons, 597 
using with Symbol Browser, 

417 
Oblique views, 577–78 

axonometrics, 577 
creating elevation, 577 
creating plan, 578 
elevation, 577 
plan, 577 
rotation angle for, 577 
settings for, 577 

Offset. See Entities,offsetting 
and copying, See 

Stairs:drawing 2D with 
DataCAD AEC 

OnSide. See Balusters, 
placement of 

OnStrng. See Balusters, 
placement of 

OnTread. See Balusters, 
placement of 

OpenStr. See Stringers, open 
Orphaned Bitmap Manager, 

using to resolve, 83 
Orphans 

using Reference File Manager 
with, 80 

XREF, resolving, 80 
XREFs, resolving, 5 

Out Sill. See Windows, drawing 
Overhead doors, 234 
Overshoot, 70, 220 

adding to existing line, 70 
displaying, 70 
setting, 70 

P 
Palettes, using customized 

colors, 221 
Pan 

with keyboard, 85 
with mouse, 85 

Pan/Scrolls, remembering, 48 
Parallel views, 567–73 

elevations, 571 
isometric, 571 
new view center as new grid 

origin for snapping, 568 
using view sphere for, 569 

Password, setting, 211 
Paste, 71, 72 
Paste Special, 71, 72 
Pattern Fills. See SPB Fills 
PDF 

batch plotting to, 470 
create drawing file as, 457 
saving layers with, 457 
saving MSP details as layers 

with, 457 
Pen Table, 459–61 

map to color, 460 
save settings in .DPF file, 461 
set pen colors, 459 
set pen density, 460 
set pen width, 460 
settings for .BMP and .JPG 

images, 431 
settings for SPB fills, 408 
use settings saved in .DPF 

file, 461 
Pen width. See Printing, pen 

width 
Perimeter, measuring circle or 

polyline, 314 
Perp. See Object snapping, 

drawing line perpendicular to 
entity 
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Perspective views, 573–77 

1-point, 575 
2-point, 576 
3-point, 576 
camera settings for, 575 
cone of vision, 574, 575 
eyepoint of, 573, 574 
focal point of, 573, 574 
hither clip in, 574 
tutorial, 176 
using view sphere for, 568 

Picture plane, 574 
Plane snap, 474 

changing zero plane 
orientation, 473 

positioning zero plane with, 
474 

Plane Snap. See Plane snap 
Plotting, 452–70, See Printing 

check plot, 458 
multi-scale, 462–67 
multi-scale layout, 462 
scale, 455 
single-scale, 462 
tutorial, 160–66 

Plotting scale. See Printing, 
plotting scale for 

Pocket doors, 234 
Point to Point, measuring, 310 
Polygons, 248–49 

converting from closed 
polyline to, 269 

hide edge of, 494 
normals, 587 
show edge of, 494 
surface area of, 544 

Polylines 
adding cover to closed, 273 
adding voids to, 277, 405 
closed, 268 
connecting two edges with 

chamfer, 274 
connecting two edges with 

fillets, 274 
converting closed shape to, 

269 
converting lines and arcs into, 

268 
converting to lines and arcs, 

268 
converting to polygon, 269 
converting to slab, 269 
converting voids to polygon, 

278 
covered, 266 
deleting an edge, 272 
drawing, 263–78 
drawing by segments, 265 
editing, 267 
editing arcs, 271 
editing vertices, 269, 270, 

271, 274 
erasing voids from, 278 
finding centroid of closed, 

276 

hatching master containing 
voids, 277, 405 

measuring area of closed, 275 
measuring perimeter of 

closed, 275 
rectangular, 264 
removing cover of closed, 273 
repositioning, 272 
tracing, 315 
tracing 2-point arcs, 315 
tracing 3-point arcs, 316 
tracing tangent arcs, 316 

PrevDist. See Distance, previous 
Preview 

plot saved as PDF, 457 
plots, 456 

Primary divisions 
of spheres, 509 
of surfaces of revolution, 513 
of torus, 511 

Printing, 452–70 
batch plotting, 467–70 
changing view to match a 

detail, 466 
check plot, 454, 458 
color, 460, 461 
copying all details from one 

sheet to another, 466 
copying one detail from one 

sheet to another, 466 
editing details, 464 
editing sheets, 464 
effective plotting area for 

paper size, 454 
erasing all details on a sheet, 

464 
erasing selected details on a 

sheet, 465 
gray scale, 460 
laying out your drawing for, 

456, 461 
layout orientation, 455 
loading pen table settings for, 

461 
moving a detail from one 

sheet to another, 466 
moving a detail on a sheet, 

465 
multiple views, 456, 462 
multi-scale plots, 461 
multi-scale plotting, 462–67 
multi-scale plotting (tutorial), 

164 
paper orientation, 454 
paper size for, 453 
Pen Table, 455, 459–61 

in tutorial, 162 
Pen Table settings for .BMP 

and .JPG images, 431 
Pen Table settings for SPB 

fills, 408 
pen width, 455 
plotting scale, 455 
preview of plot, 456 
quick layouts for, 455, 462, 

468 

renaming sheets, 464 
rotating plot for, 455 
saving pen table settings for, 

461 
selecting printer for, 453 
sheets in batches, 468 
toggling layers on in a detail, 

465 
tutorial, 160–66 
updating a detail on a sheet 

with layer settings, 465 
using pen table settings, 461 
widths of pen passes, 460 

Program Preferences 
background color, 37 
creating new drawing with 

default, 13 
DXF/DWG import, 42 
menu button font, 37 
pathnames, 32 

Program, launching external in 
DataCAD, 101 

Project 
drawing efficiently, 60 
managing, 182 
planning entire, 58 
planning layers, 59 
Project Directory, 182 
sample, 61 
set files, 469 

Projection pad, toolbar, 21 
Purging, with Purge Drawing 

dialog, 94 

Q 
Quadrant. See Object snapping, 

to nearest quadrant point 
Quick. See Object snapping, 

increasing speed of 
Quick Layout. See Printing, 

quick layouts for 
Quick Search. See 3D entities, 

selecting curved 
Quick snapping, 475, 479 

R 
Radians. See Angles, setting 

types of 
Radius 

curve, dimension of, 396 
draw circle based on, 258 
of 3D stair handrails, 647 
of arc, changing, 255 
of balusters, 649 
of circles, 498 
of cones, 505 
of curve, measuring, 311 
of curved stairs, 642 
of horizontal cylinders, 501, 

503 
of newel posts, 651 
of torus, 511 

Rafters, drawing, 489 
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Rails. See Stairs, drawing 2D 

with DataCAD AEC 
RAY files 

exporting, 100 
light sources in, 100 

Raytrace, with Object Viewer, 
598 

Recovering 
lost drawing, process for, 91 
lost files, 91–94 

Recovering lost drawing 
process for, 93 

Rect. Array. See Copy, 
rectangular array 

Rectangl. See Newel posts, 
rectangular, See Balusters, 
rectangular, See Handrails, 
rectangular 

Rectangle. See Polylines, 
drawing rectangular, See 
Drawing, rectangles 
drawing, 249 
drawing 3D polygons, 482 
drawing slabs, 482 

Rectangular arrays, 557 
Redo, 71 
Ref. Point. See Reference point, 

floating 
Reference File Manager 

accessing with pop-up menu, 
81 

binding reference files with, 
77 

deleting reference files with, 
78 

disabling nested XREF 
display, 79 

displaying nested XREF with, 
79 

displaying selected layers 
with, 75 

highlighting XREF entities 
from, 78 

inserting reference files, 72 
refreshing files with, 76 
reloading reference files with, 

76 
using, 74 

Reference point, 298–300 
fixed, 298 
floating, 298 
show current, 50 
using with direction distance, 

300 
Referencing 

files, 72–80 
image files, 430 

Referencing drawings, 72–80 
and binding, 77 
and displaying layers in, 75 
and refreshing, 76 
and reloading, 76 
context-sensitive pop-up 

menu for, 80 
deleting, 78 
disabling nested, 50 

highlighting, 78 
orphaned, 5, 80 
resolving orphaned, 80 
retaining highlight settings, 50 
self-referencing XREFs, 73 
using Reference File 

Manager, 74 
using stamps, 429 
with unique clipping 

boundaries, 74 
Reflection line, defining, 295 
Relative Cartesian entry, 64 
Relative polar entry, 64 

drawing line with, 65 
Remove 

cutouts in walls, 233 
doors, 237 
windows, 241 

Rename. See Layers, renaming 
Rendering 

by color, 600 
by layer, 599 
settings for, 599–604 

Rendering, defining materials for 
each layer, 198 

Reports 
about symbols, 426 
generating for symbols, 426 
symbol text attribute data, 380 
using Report Forms dialog, 

426 
Rev. Surface. See Surfaces of 

revolution 
RghtExtn. See 3D stairs, treads 

of 
Right-hand rule, 567 
Rise angles, 508, 512 
RiserHgt. See 3D stairs, riser 

height of 
Risers, 644 

color of, 644 
height of, 644 
thickness of, 644 

RndNosng. See Nosing, for stair 
treads 

Roll angles, 510 
Roof framing, 609–18 

overhang for, 611 
pitch for, 610 
purlin height for, 610 
rafters for, 610 
sheathing for, 610 
with FrameIt, 609 
with RoofIt, 611 

Roofs 
A-frame, 487 
dormer, 488, 489 
exterior elevations of, 439 
framing, 609–18 
gable, 487 
hip, 487, 488 
mansard, 487 
rafters for, 489 
shed, 487 

Roofs, 3D 
adding (tutorial), 171 

boundaries for, 612 
joining, 614 
modeling, 611 
polygonal, 613 
rectangular, 613 
settings for, 616 
types of, 611 

Rooms, labels for, 381 
Rotate 

3D entities, 558–59 
and copy entities, 342 
area selection toggle, 51 
center of 3D, 559 
dynamically, 343 
entities, 342 
setting new angle of, 344 

Rotation angles 
in 3D views, 567 
setting, 571 

Ruled surface, 544 
between two closed 

concentric polylines, 546 
between two contour lines, 

544 
treated as TIN model, 547 
using 3D Knife with, 547 

S 
Sashes, for 3D windows, 624 
Save All. See Drawings, saving 
Save As. See Drawings, saving 
Save Delay. See Saving 

drawings, delay for automatic 
saves 

Save Image. See Hidden line 
removal, saving image of 

Saving 
automatic, 218 
drawing sessions, 48 
drawings, 86 
drawings, delay for automatic 

saves, 218 
layers, 195 

Scale. See Printing, plotting 
scale for 
drawing, 49 
plot, saving current, 48 
plotting, 49 

Scales 
architectural, 215 
engineering, 215 
metric, 216 
setting types, 212, 213 

Screen calibration, 35 
Screen coordinates, 570 
Scroll distance, 20, 85, 218 
Search Hatch. See Object 

snapping, to hatch lines 
Search, contour of closed 

polyline, 267 
Secondary divisions 

of spheres, 509 
of surfaces of revolution, 513 
of torus, 511 
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Sectioning tool, 3D, 548 
Sections, 447–49 

cabinet, 448 
cabinet styles for, 449 
creating 2D sections from 3D 

model, 548 
SectnLin. See Stairs, drawing 2D 

with DataCAD AEC 
Sel. Set. See Object snapping, to 

entities in active selection set, 
See Selection, by selection set 

Select Fill Color/Pattern, 406 
Selection 

3D, by area, 52 
3D, by fence, 52 
by area, 50, 51 
by crossing, 50, 51 
by entity, 50, 51 
by fence, 50, 51 
by group, 50, 51 
by layer search, 51 
by point, 50 
by selection set, 51 

Selection sets, 52, 349–53 
adding entities automatically 

to, 353 
adding entities to, 349 
clearing, 352 
deleting entities from, 350 
displaying entities in, 349 
naming, 352 
replaced by Mask, 52 

Self-XREF, inserting, 74 
Set Active. See Layers, setting 

the active, See Layers, 
changing the active 

Set All, 309 
Set Index, creating series of 

concentric contours with, 528 
Set Snap. See Grids, changing 

size of 
Set Z User 2. See Z alternative 

elevations, setting 
SetBays. See Windows, curved 

bays of, See Windows, linear 
bays of 

Settings 
add value definitions, 213 
angle type, 212 
change value definitions, 214 
changing 3D, 476 
cursor miss distance, 216 
delete value definitions, 214 
display big cursor, 217 
display draw marks, 217 
display negative coordinates, 

217 
edit angle definitions, 213 
edit distance definitions, 213 
edit scale definitions, 213 
for drawings, 211 
load custom definitions, 215 
number of primary divisions, 

475 
number of secondary 

divisions, 476 

panning distance, 218 
password, 211 
save custom definitions, 214 
scale type, 212 
scroll distance, 218 
smallest grid, 217 
Z-elevations, 476 

Setup program. See Installation 
of DataCAD 

Shaded image, 584–88 
creating, 584 
saving, 588 
saving shader settings, 587 
settings for, 584 
using a .LIT file, 588 

Shader 
background color of, 585 
background image, 586 
cast shadows, 586 
checking normals of 

polygons, 586 
creating shaded image with, 

584 
draw edge lines, 586 
edge type, 586 
entity receiving shadow, 587 
highlight, 586 
light settings, 584 
loading light information, 588 
overshoot lines, 586 
rendering, 586 
saving settings, 587 
settings for, 584 
shadow plane, 587 
show lights, 586 
sun light source settings, 585 

Shading, 584–88 
Shed roofs, 487 
Shortcuts 

creating keyboard, 670 
creating keyboard for pull-

down menu options, 674 
defining keyboard, 671 
standard keyboard, 672 

Show Values. See Text, 
displaying styles 

ShowVals. See Walls, displaying 
styles 

ShowZ. See Z-base, displaying, 
See Z-height, displaying 

Sig. Digits. See Decimal, place 
setting 

SigDigit. See Scales, setting 
types 

Sill Height. See Windows, 
drawing 

Sills 
for 3D doors, 628 
for 3D windows, 623 

Single doors, 234 
Single tee concrete forms, 

drawing, 633 
Site model with drop mesh, 520–

27 
Sketch, using Freehand to, 296 

Slab Refs.. See Slabs, reference 
face markers 

Slabs 
adding vertices to, 492 
converting from closed 

polyline to, 269 
deleting vertices from, 493 
editing, 492 
hide edge of, 494 
horizontal, 483 
moving vertices in, 493 
rectangular, 482 
reference face markers, 485 
show edge of, 494 
thickness of, 482, 486 
vertical, 484 

Sliding doors, 234 
Small Grid. See Display, 

options, setting 
Small Symbol. See Symbols, 

smallest display size 
Small Text. See Text, displaying 

smallest size 
Smooth Pass. See Contours, 

smoothing surface 
Snap grid 

changing size of, 184 
matching to an entity, 319 
new view center becomes new 

grid origin, 568 
setting (tutorial), 104 
setting angle of, 185 
using, 183 

Snap Point. See Snapping, point 
adding 

SnapAngle. See Snap grid, 
setting angle of 

Snapping, 300–308 
3D point, 480 
adding to Get X distance, 307 
grid origin for, 568 
object, 300 
on layers, 475 
plane, 474 
point, adding, 301 
quick, 475, 479 
subtracting from Get X 

distance, 307 
to add to or subtract from 

defined angle, 307 
to define an angle, 307 
to enter horizontal distance, 

306 
to enter vertical distance, 306 
using middle mouse button 

for, 301 
virtual, 308 
with Get-Snap, 306 

Solid Fills. See SPB Fills 
Sorting 

layers, alphabetically, 202 
layers, by color, 202 
layers, by layer number, 202 
layers, by lock status, 202 
layers, by number of entities 

in, 202 
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layers, by on/off status, 202 
using Layer Manager for, 201 

SPB Fills, 406 
choosing colors for fill and 

pattern, 407 
choosing pattern, 407 
controlling X/Y aspect of 

bitmap fills, 407 
moving entities on same 

layer, 340 
moving filled entities, 408 
printing controls with Pen 

Table, 408 
selecting .BMP or .JPG 

image, 407 
swapping entities on same 

layer, 341 
using instead of hatch 

patterns, 406 
using Select Fill Color/Pattern 

dialog, 406 
Spelling 

adding word to user 
dictionary, 366 

checking for and correcting 
errors, 363 

modify checking criteria, 364 
Spheres, 509 

beginning rise angle for, 508 
drawing, 508 
ending rise angle for, 509 

SqrNosng. See Nosing, for stair 
treads 

Stack Frac. See Fractions 
Stairs 

3D, 278–80 
creating 3D with Z-elevations 

in rectangular arrays, 294 
drawing 2D with DataCAD 

AEC, 278–80 
Stamps 

format exported, 48 
inserting in drawing, 429 
values updated automatically, 

429 
Start Ang. See Curves, drawing 
Start Angle. See Angles, setting 

types of 
Status panel 

active layer, 23 
layer search toggle, 24 
toolbar, 22 

Stiffness. See Contours, stiffness 
of 

STL files 
exporting, 99 
inserting into drawing, 81 

Stops, for 3D doors, 629 
Stretch, 344 

3D entities, 560 
changing arc radius with, 255 

StrForm. See 3D stairs, form 
Stringers 

closed, 646 
color of, 647 
in center of stairs, 646 

on left side of stairs, 646 
on right side of stairs, 646 
open, 646 
thickness of, 646 
width of, 646 

StrWell. See Stairs, drawing 2D 
with DataCAD AEC 

StrWidth. See Stairs, drawing 
2D with DataCAD AEC 

Styles 
arrow options for angle and 

curve dimensions, 395, 397 
for automatic linear 

dimension, 389 
for automatic linear 

dimensions, 393 
for linear dimension arrows, 

387, 388, 392 
for linear dimension lines, 

387, 388, 391 
for linear dimension text, 387, 

388, 390 
for walls, 230 
line options for angle and 

curve dimensions, 395, 397 
text options for angle and 

curve dimensions, 395, 396 
Surfaces of revolution, 511 

drawing, 512 
Survey data file 

creating drop mesh from, 520, 
521 

creating TIN model from, 532 
deleting duplicate points 

from, 533 
Swapping, SPB-filled entities on 

same layer, 341 
Swing Color. See Doors, swing 

color of 
Swng Style. See Doors, swing 

style of 
SWOTHLUDFB, 24 
Symbol Browser 

deactivating Explode in, 423 
deleting symbol from, 425 
docking, 413 
editing symbols with, 421, 

424 
exploding symbol with, 421 
opening symbol collection, 

415 
placing symbols using, 417 
reloading symbol definitions 

with, 426 
replacing symbols with, 425 
retaining settings for, 428 
selecting symbols from, 417 
undocking, 412 
using Object Viewer with, 

417 
viewing symbols with, 417 
X and Y divisions for, 414 

Symbols 
3D windows as, 620 
adding text attributes to, 376, 

428 

angle of rotation, 420, 423 
attributes in DWG file, 14 
balusters as, 649 
changing size of, 678 
changing Z offset, 421 
converting to lines and arcs, 

679 
copying (tutorial), 153 
creating, 423, 683 
creating a handle for new, 423 
creating text attributes for, 

377 
customizing layer settings for, 

428 
defining new, 423 
defining text attributes for, 

376 
definition of, 426 
deleting from drawing, 686 
deleting from template, 687 
deleting unused from 

drawing, 428 
dragging to position, 417 
editing, 421, 684 
editing information about, 424 
editing information fields of, 

685 
editing information fields 

with FormAtr macro, 685 
editing text attributes of, 380 
enlarging, 420, 680 
erasing, 687 
exploding, 421, 679 
exploding and editing while 

placing in your drawing, 
684 

files, finding and using older, 
679 

fixed rotation, 420 
generating report on text 

attribute data, 380 
inserting, 417, 678 
inserting in drawing without 

Symbol Browser, 678 
inserting into labels, 382 
inserting with Template, 679 
inserting with Z offset, 680 
insertion points displaying, 

220 
layer settings for, 428 
mirroring, 420 
naming, 683 
newel posts as, 651 
of 3D doors, 626 
offsetting insertion height of, 

421 
opening (tutorial), 148 
opening another (tutorial), 

152 
opening collection of, 415 
placing, 415–18 
placing (tutorial), 149 
placing in drawing, 417 
preview, 49 
previewing, 678 
purging from drawing, 687 
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purging unused from drawing, 

428 
reducing, 420 
replacing, 686 
replacing several, 686 
reports about, 426 
rotating, 678 
rotating dynamically, 420 
saving, 423, 683 
selecting, 415–18 
selecting (tutorial), 149 
setting angle of rotation, 420 
settings shown in Attention 

toolbar, 419 
smallest display size, 220 
text attributes for, 376, 428 
using stamps, 429 

System requirements, 3 

T 
T Intersect. See Intersections, 

cleaning T 
Takeoffs, 313 
Tangent arcs, tracing, 316 
Tangents. See Obejct snapping, 

tangent to arc 
contours, 527 
drawing 3D arcs as, 498 
temporary line, drawing arc 

using, 257 
Template files, finding and using 

older, 679 
Templates, 681–83 

changing number of divisions 
in, 682 

creating, 681 
creating additional 

information fields for, 682 
divisions, 681 
editing, 682 
fields, 681 
naming, 681 
opening another, 681 
selecting symbols from, 680 

Text, 358–83 
adding attributes to symbols, 

376, 428 
adding to drawing, 358 
adding word to user 

dictionary, 366 
adjusting to fit in area, 362 
aligning, 361 
arrows, drawing (tutorial), 

137 
attribute, generating report on, 

380 
attributes for symbols, 376, 

428 
changing angle of, 359 
changing appearance of, 358 
changing aspect ratio of, 359 
changing attributes of, 332 
changing properties of 

TrueType font, 359, 374 

changing scale of, 360 
changing size of, 359 
changing style of TrueType 

font, 359, 374 
changing weight of, 359 
checking and correcting 

spelling, 363 
creating attributes for 

symbols, 376, 377 
deleting styles, 372 
displaying, 219 
displaying smallest size, 220 
displaying styles, 372 
drawing arrows, 373 
editing (tutorial), 138 
editing symbol attributes, 380 
entering directly into drawing, 

359 
exporting, 371 
importing, 371 
inserting, 360 
inserting notes (tutorial), 136 
inserting room names 

(tutorial), 135 
inserting TrueType text in 

drawing, 375 
justifying, 360 
loading styles, 372 
menu, 49 
modifying spelling criteria, 

364 
scale, 49 
setting attributes (tutorial), 

134 
setting parameters for 

TrueType fonts, 374 
style for dimensions, 387, 388 
style options for angle and 

curve dimensions, 395, 396 
styles of, 371 
using TrueType (TTF) fonts 

for, 374 
Thickness 

of 3D stair landings, 644 
of 3D stair risers, 644 
of 3D stair stringers, 646 
of 3D stair treads, 645 
of doors, 237 
of slabs, 482, 486 
of vertical cylinders, 501 

TIN Model 
concentric steadily rising 

contour lines for, 530 
controlling contour divisions, 

538 
creating contour lines for, 529 
cutting polygons from, 541 
deleting duplicate surveyor’s 

points, 533 
flip valley between two 

triangles, 540 
generating from contour lines, 

530 
generating from Marker 

points, 532 

generating from surveyor’s 
points, 532 

generating points with Marker 
for, 531 

generating with smoother 
edges, 535 

using 3D knife, 541 
using color slice, 536 
using edge factor for, 535 

TIN Modeler, 529–43 
Title block 

boxes in, 434 
creating (tutorial), 156 
defining, 434 
detail blocks in, 435 
drawing, 435 
location of, 434 
size of, 435 

To Layer. See Copy, to another 
layer, See Layers, moving 
entities to another 

Tool tip, 18 
Toolbars, 18 

action codes for, 664 
Architect context-sensitive, 

226 
attention, 24 
context-sensitive, 22 
coordinates, 24 
creating custom, 662 
creating icons for, 663 
customizing, 19 
dialog box, 19 
Draw, 41 
drop-down items, 663 
Edit, 41 
hints, 24 
hotspots in status panel, 23 
icon button size, 663 
icons access menu functions, 

18 
locking, 18 
message, 24 
moving, 18 
multiview windows, 25 
navigation pad, 20 
projection pad, 21 
selecting default, 40 
standard, 19 
status panel, 22 
SWOTHLUDFB, 24 
unlocking, 18 
viewer, 21 
viewing with Navigation 

icons, 85 
view-sensitive, 21 

Toolbox 
3DStairs, 278–80 
Concrete, 632 

Torus, 510 
beginning roll angle for, 510 
ending roll angle for, 510 
primary divisions of, 511 
radius of, 511 
secondary divisions of, 511 

Tracing 
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2-point arcs, 315 
3-point arcs, 316 
polylines, 315 
tangent arcs, 316 

Translator 
default settings for 

DXF/DWG files, 43 
DWG/DXF, 656 
importing DWG and DXF 

files with, 14 
Trd/Run1. See 3D stairs, treads 

in first run of 
Trd/Run2. See 3D stairs, treads 

in second run of 
Trd/Run3. See 3D stairs, treads 

in third run of 
TrdLngth. See 3D stairs, tread 

length of 
TrdWidth. See Stairs, drawing 

2D with DataCAD AEC 
Treads, 645 

color of, 646 
depth of, 645 
extensions of, 645 
nosing for, 645 
thickness of, 645 

Trim 
for 3D doors, 627 
of 3D windows, 622 

Trimming, 322–26 
entities, 324, 325 
entities to end at a specified 

line, 324 
entities to intersection of two 

lines, 325 
entities, specified, 325 

TrueType fonts. See Fonts, 
TrueType (TTF) 
converting to 3D, 376 
inserting text in drawing, 375 
setting text parameters for, 

374 
using instead of CHR fonts, 

374 
TrueType fonts (TTF), 374, See 

Text, using TrueType (TTF) 
fonts for 

TTF. See TrueType fonts 
Tutorial 

3D viewing, 164 
adding layers, 104 
assigning layer colors, 106 
automated 3D modeling, 168–

74 
border, creating, 154 
border, moving, 155 
changing active layer, 105 
cleaning wall intersections, 

114 
dimensions, automatic, 142 
dimensions, drawing string of, 

140 
dimensions, setting, 139 
dimensions, stretching, 143 
drawing 

doors, 120 

windows, 125 
drawing text arrows, 137 
drawing walls, 107 
editing text, 138 
hatching, 145 
inserting notes, 136 
inserting room names, 135 
multi-scale plotting, 164 
printing, pen table, 162 
renaming layers, 104 
setting snap grid for, 104 
setting text attributes, 134 
symbols, copying, 153 
symbols, opening, 148 
title block, creating, 156 
viewing 3D model, 174–80 

U 
Undo, 71 
Ungroup. See Entities, 

ungrouping 
Units. See Scales, setting types 
UnitType. See 3D windows, 

types of 
Up Left. See Stairs:drawing 2D 

with DataCAD AEC 
Up Only. See Stairs:drawing 2D 

with DataCAD AEC 
Up Rght. See Stairs:drawing 2D 

with DataCAD AEC 
UpAndDn. See Stairs:drawing 

2D with DataCAD AEC 

V 
Vertex 

adding, 269, 492 
deleting, 270, 493 
moving, 269, 270, 493 
moving while keeping angle, 

269, 271 
of polygons, 249 

Vertical 3D polygons, 484 
Vertical cylinders 

divisions of, 501 
thickness of, 501 

Vertical slabs, 484 
VertOfst. See Balusters, vertical 

offset of 
View center 

changing with Edit Plane, 568 
changing with New Elev., 568 
repositioning, 568 

View Layer. See Layers, 
viewing 

View sphere, 568 
changing eye point for view, 

568 
formerly "globe", 568 
moving, 569 
operating, 569 
repositioning in Drawing 

Window, 569 
using for parallel views, 568 

using for perspective views, 
568 

Viewer/Shader 
defining materials with, 600 
saving material assignments 

in .DMF file, 603 
using for color mapping, 599 

Viewing 
3D models (tutorial), 171 
advanced 3D (tutorial), 175 
changing, 175 
layers, 191 
selected entities in 3D model, 

588 
using arrow keys for, 85 
using Clip Cube for, 588 
using Navigation toolbar for, 

85 
Views 

3D oblique, 577–78 
3D perspective, 573–77 
adding current to GoTo View 

list, 592 
changing, 175 
changing an existing GoTo 

View, 592 
changing center of, 568 
deleting an existing GoTo 

View, 592 
isometric, 571 
linking an entity to a GoTo 

View, 593 
moving an existing GoTo 

View, 592 
parallel, 567–73 
perspective (tutorial), 176 
remembering previous, 48 
renaming an existing GoTo 

View, 592 
shaded image, 584–88 

Virtual snapping, 308 
Visibility 

hide edge of polygon or slab, 
494 

show edge of polygon or slab, 
494 

Voids 
adding, 491 
adding to polyline, 277, 405 
converting, 491 
converting to polygon, 278 
erasing, 491 
erasing from a polyline, 278 
hatching polyline that 

contains, 405 
Volume, measuring circle or 

polyline, 314 
VRML files, exporting 3D 

models to, 98, 99 

W 
Walk through a model 

customizing options for, 594 
looking, 596 
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perspective navigation 

controls, 594 
perspective view, 593 
saving a view of, 596 
stepping, 595 
turning, 595 
using hotkeys, 594 
using MouseWheel, 594 
Viewer toolbar, 593 
walking, 595 

Wall framing, 608–9 
plate settings for, 609 
stud settings for, 609 
wall height for, 609 

Wall Style Manager, 230 
deleting wall styles with, 232 
displaying wall style settings, 

232 
saving changes, 231 
specifying options, 231 
using wall styles, 231 

Wall Thk. See 3D windows, wall 
thickness for 

Walls 
2-line, 226, 227 
3-line, 226, 227 
3-line attributes, 227, 229 
4-line, 226, 227 
4-line attributes, 229 
attributes, 228 
capping, 227, 230 
cleaning, 229 
cleaning (tutorial), 114 
cleaning intersections, 227 
cutting, 232 
cutting, for 3D doors, 625 
cutting, for 3D windows, 620 
defining by cavity center, 227 
defining by center, 227 
deleting styles, 231 
displaying styles, 232 
drawing, 226–33 
drawing (tutorial), 107 
finishing for models (tutorial), 

172 
framing, 608–9 
loading styles, 231 
removing opening from, 233 
setting attributes of, 227, 228 
styles, 230 
welding, 237, 327 

width of, 228 
WallStyl. See Walls, styles 
Welding, 326 
Width 

of 3D stair handrails, 647 
of balusters, 649 
of newel posts, 651 
of stair stringers, 646 
of walls, 228 

Windows 
adding 3D (tutorial), 168 
curved bays of, 244 
drawing, 238–46 
drawing (tutorial), 125 
drawing in elevations, 443 
labels for, 383 
linear bays of, 241 
modeling 3D, 620–25 
mullions, 243, 245 
removing, 241 
width of jamb, 239 

WndwFile. See 3D windows, 
files 

WndwForm. See 3D windows, 
forms 

World coordintates, 570 

X 
X Enlargmnt. See Enlarge, in X 

direction 
X Intersect. See Intersections, 

cleaning X 
XREF. See Referencing 

drawings 
circular, 73 
highlight settings, retain, 50 
inserting into drawing, 73 
inserting self-XREF, 74 
nested, disable, 50 
resolving orphaned, 80 
self-referencing, 73 
with Clip Cube, 74 
working with nested, 79 

XREF Clip. See Clip Cube, 
defining in XREF with XREF 
Clip 

Y 
Y Enlargmnt. See Enlarge, in Y 

direction 

Z 
Z alternative elevations, setting, 

477 
Z By Layer, 199 

settings for current layer only, 
472 

Z Enlargmnt. See Enlarge, in Z 
direction 

Z Inc. X. See Arrays, using Z 
elevations in rectangular 

Z Inc. Y. See Arrays, using Z 
elevations in rectangular 

Z offset, for symbols, 421 
Z-base 

displaying, 217 
for 3D lines, 472, 476 
setting for each layer, 199 
to thickness, 482 
to Z-height, 482 

Z-Dist. See Distance, stretch in Z 
direction 

Z-elevations 
changing, 476 
using in rectangular arrays, 

293 
Zero plane, 472–75, 477 

and New Elevation Indicator, 
572 

Z-height 
displaying, 217 
for 3D lines, 472, 476 
setting for each layer, 199 
to thickness, 482 

Zoom, 84 
free zoom using menu, 85 
to extents of drawing, 84 
with Navigation toolbar, 85 

Zoom options, 32 
scroll wheel and, 49 

Z-User 1. See Z alternative 
elevations 

Z-User 2. See Z alternative 
elevations, setting, See Z 
alternative elevations 

 
 


